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H ARSI
OS clients
Engineering
Station ‘J ‘J e =l
| . 1| I l I l Terminal bus Industrial Ethernet
|. | |
= 2 redundant
OS server OS server U BATCH
L ~—- Single
| L [ ,.,:;L |- . | Station
[ Plant bus Industrial Ethernet ] o //-'//5§

Industrial

SIMATIC PCS 7 BOX

SIMATIC PCS 7 BOX i n] FHAE /NN, REE 1) TR . BEZACE R, 1S T
G R &4 PCS 7; SIMATIC PCS 7 BOX)
(Process Control System PCS 7; SIMATIC PCS 7 BOX).
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PCS 7 Z4 119 PC 41 1F
2.5 L FENias o s r

253 FEBRA PC LA & TR AR AE A v

A PC LB RISk AN ER A R i

AL AN TR A BT PCS 7 414 (OS. BATCH. 4e45iil. AS) FEhds—A /i
ARG GBI TR o VB, TR TR AR A Gt 45 A e — A

PURSEIA S o T RAEIFIN L) 180 B2 1) MHZ R 2o U MR H AR RS
PAHEAT IO ] I e srp

Engineering Station and
Operator Station

Q
|TH |,
Industrial Ethernet //'-/g
| - In({s::m
Automation system i’lﬂl{ |||| ;J
—
AS 400 IiI.I_H::::_I | . - ||
- SIMATIC
FROFIBUS DP Distributed /O PCS 7 BOX

SIMATIC PCS 7 BOX

SIMATIC PCS 7 BOX thn] HAE/ NS, RGE I TRENS, . AR EMEZE R, W5%
“SIMATIC PCS 7 BOX 3fi | (ifi 30) 7 #4r LA LT (b Fegsihl 248 PCS 7;
SIMATIC PCS 7 BOX) (Process Control System PCS 7; SIMATIC PCS 7 BOX).
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2.6 Z 1 Ei5 R HIME R Ty %

2.

6

2.6.1

2 TARM RGMIMFRTT R

BIE RIS TAEMARR

TERRAZ -G R G B0 2 TR R RIBRAE 53 3

20

0S Z T RGHZ A 08 &)L CLAE) AR, X Hlh—A4 OS g as (%
A~ OS Hudss) it Zun i k (OS LAN) Skttt (T H $cdls . REFR(E. U, SRERH
ISP

OS JlugsastmZ ALY 32 4> OS %) Hlig Al Pl .

OS % Wi % nT LAH I Vi) 12 4~ OS JIkgs#s LI (2% Has= .

W2 VGA RixZ i 4 ML as &S TR (OS 2 Hl) o Has AN AN BlbR
BRIV RT3 1 b LT B AR G DX Ak

0S8 essas R btmiz i plohfe, PULar Bl e OS MRssas LR (. JIRS. 3
B AR o A, KA OS st bRk Reminth il LA & T OS 454k AR
WA HEITA OS kg5 as sl I BAT AR A1 2 A OS s, w ABRAGHR AT DA sty i)
. AEITA OS flidsasiti 2 OS BATUARME A 45 L

Vi BH
WIRTE OS k4543 HizdT OS & WAL PUAS, W BAHE OS NR45#s HIAE A A A
T AR,
Archive server OS clients
B B
Ll |
I I Terminal bus Industrial Ethernet

I redundant ... OS server

LT OS server | ;,I.,.Al. OS server max. 12 (redundant)

&
- B

Plant bus Industrial Ethernet

Ethernet

Industrial
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PCS 7 Z4 119 PC 41 1F
2.6 Z 1 Eu5 R I T 5

R A R 55 2%
HPKS OS kG5 22 Ay Hh SRR A 45 2%
o PR JTRIRSS B L M LI AN, AT R,
o AR R RS B AT TR AL
HORUL R ELAE R, 5% <RI RR S ST RIAR (i 26) ” #4)

Y TAHEus
Yegp TAESS SN2 WIS AR R G, K TR D 4edn & Bl (MS &L
ARETENELZHER, 5%
o Ui TAEMIZ TAEMI RS (UhY 24) 7 Hisy

o (AT CGIREHIRSE PCS 7, #AE hiuk)
(Process Control System PCS 7, Operator Station)

e R 2 T RS PCS 7 OS Web &4

£ PCS 7 1, nfLUfH] Internet Explorer K1jjin] PCS 7 1) 1) OS, Hif&& i fri% OS sk
T PCS 7 OS Web i3 HAE M2 s & T A EE 77 I AR .

ORI FEIEE, W3% “(ff PCS 7 OS Web & fFifiyin) OS| (1ifish 32) 7 f4rs
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2.6 Z 1 Ei5 R HIME R Ty %

2.6.2

BATCH % T/EW R4

EA KRR P H-IRES /ARG Z TAEW RS K BATCH 3
e BATCH uiZ TAEui R4t 2> BATCH & /0L CLAERD 4pk, XLe& P HLii— BATCH

22

45 A I 2ty SRR A (IUE s SRR VIR, BRI ED
—A BATCH k45285 £ 1 1) 32 4> BATCH % ) Hl42 b F 80k .

£ PCS7 L) ™, X+ —4 BATCH ilz554% Hitfs —4> BATCH I H .
fE—A BATCH JIk 45 %8 b U n] LU —~ BATCH JiiH .

i —A BATCH & WL 424> PCS 7 RSk THEA M. Mk, NS5 BATCH %)
HLERIZ A BATCH % WL TR R IELE B sh ik # AR A ) BATCH Wi H  (BEANHH —A
BATCH R45#%) o FItEILT, BESRILZ VGA KK S .

WA A4 BATCH JIR4-48, w348 PCS 7 1) frmnl . #t PCS 7 10 H P iR 2e 5k
HIMS, TURAAR BATCH RS # 2808 #.4 BATCH JiR45 4% .

B
WA BATCH JIig54s B34 BATCH &/ HLANERE 4 4>, WIRTLL{E PCS 7 V6.0 SP3
LS RRAS R % BATCH Ji 55 & V4R A D145 AT T A0t o

OS clients BATCH server BATCH clients
e e
\ Lk
| | | | Terminal bus Industrial Ethernet
| OS server | OS server ... max. 12 servers
L b R (redundant)
[ Plant bus Industrial Ethernet ] §

Industrial
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PCS 7 ZZ19 PC 41T

2.6 Z 1 Eu5 R I T 5

26.3 B S TR 2 TR R4

Ve R % P HL-BR S A R G5 B0 2 TAR UG R A M B AR 1) T Ao

BARTR I TAR w2 TAE s Rt 2 stz P pL COARSD 4U8, X% Ll — Mk
A il e 5% s o v S R PR AR (U Bt . SRR VA IREATNHED .

B R R T 32 B P LB O R
7 PCS 7 RAT, — MR RIS 8 U MR RIH (ML
BB S5 2 T SRS OS LTEREINAL.

IS VOA R E T 4 AN BER B T (el bl o SR AN SR
BB AT U PR 51K B

S AT A B ARG e, TR G BB T A B T IR 3% PCS 7 S b
SBT3, O AR LA IO PR TR 638 Al 0L 2 PR 55 5

L]

I RAERC AR P R 55 A _ BRI AR T WAL 4 A4S, WIRTLAAE PCS 7 V6.1 J 3
1o A FFORZ B A7 T IR 55 A 43 A D R L T A o o

A 2541
OS clients Route Control clients
Ei —_ Ei hi
I I I I Terminal bus Industrial Ethernet
|* OS server I Route Control
—l-'lw . —I-l" = server
[ Plant bus Industrial Ethernet ] //-'//E“
== IndustriaILLI
PC 414584
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PCS 7 Z4 119 PC 41 1F
2.6 Z 1 Ei5 R HIME R Ty %

2.6.4 HeP TAEW 2 TIEW RS

Yy TR
#ep TAESE T PCS 7 T Wikl PCS 7 T B4 L) PC 3.
Y T AR R AL
o YRS (MS RS %D
o UHESHL (MS FHFHL

TERRAZE P H-IRE /ARG Z TN RAER 4D TR

Y TAESEZ TAEE RS MS 0L CEAESD ARG 22 Bl MS JIeds s fe it 8ids (o
FIEGE . AR, SRR ED .

e MS %J'Hl
MS % WL 2 W iR v AR 2 Wk A, RO R S E RIS L ShRE. Ak, K5 MS
HPHLALA N TR .

o MS Jlis e

MS Ik 55 &h R G08 Wi o 1) i o 5 S A B SEh 2] A PC L. MS 5548 75 28 1 51 K
£ MS %) L st B

- KB OS fIk55as iR 55 s Hdh
- MZAFIAE

M2 VGA RiZ K 4 MRS ERESIZE TR (MS 2L o JU F AT Bl b )
F AT BT B R e X

M HZTCARI MS 55 4%,  FIPATLES TAR w1 i m] A

Engineering Station
with MS client

OS clients
- )
| | | | Terminal bus Industrial Ethernet
| || MSserver T OS server ... max. 12 servers
_I' _r (redundant)
[ Plant bus Industrial Ethernet ] //_-//i;

Industrial
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2.6 Z 1 Eu5 R I T 5

A RZBYEY TAESHIE R
LR RE P R AR UL
® MS fiR55as LN RGCHIM AN OS Medsas.

o MS &MU TR — N fE. AXRASHVY, TSHAETM GIREEH RS
PCS 7; #:1EHuk) (Process Control System PCS 7: Operator Station)

ARZEMNEZAER, AIS% Ui PCS 7 Bt (Uih% 82) 7 #lis).

UpIIEEYS
o [ “ICUANTIAAS (DihE 193) 7
o AT CdrefEhlzRg: PCS7; #:A4E fuk)
(Process Control System PCS 7; Operator Station)
PC 41 54
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PCS 7 #4519 PC 211

2.6 Z I 1EuE R HIFEI %

2.6.5

faifr

Lhie

Vi il fR

I A R YA R 55 AR HEAT Y VA

o R AR R 55 i 1A e ook B PCS 7 AN RIS 24T I RS o A o
ARG IRSS 2%, T L AN OS VARG ALE A I M S AE AV B . OS & LA A SIMATIC BATCH (1)
fLALFR R . ot PCS 7 isAT RGHPIRAS W, HRS v o XFEEE nT LA Internet
Explorer 17 i Wi 412X 1 BT 4 2580

I TOAR A RIARIHR S5 & T LASEIL A S YR e 55 45% 0 vl P

AP A YR 25 4% 1T LLSRAT BAR D«

1

¥k 8 PCS 7 OS 13 BRI R AR Y
JHRY OS ik

¥k H SIMATIC BATCH [t Ad B4t I 4%
K T VR RY H50H0s 4325 B S A7 il A o

Ay JIT A VERS e i o) S
AL e AR ThAE Ry

A Pt e o i LA B TR R 1 T X s i A
Kt B LL CSV Bk XML U B Gt
R AR T () AR KA

FEHET web 1) 505 11 b o E RS A

AT AR SRS A 2545 R P 5 e AR, Al A2 i OR

R B I SRR R 5538 HOTE R T
LR R RAE R LR LA

26

NBEETERE, RN PC g2 p AR IR 55 45 -

U RAID RGRHN R se bk
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PCS 7 ZZ19 PC 41T

2.7 W Eu5 R HIME T 5

2.7 BT RERIMRRTT R

271 OS HA T 1Euk

HASPC HEA R TR ARSH OS
e OS M ITAEui A PC L HA PCS 7 I H T (TG B AE 5342 51D AR Th B8 i $AE b1h
GEFEHIT/AT)

o ) Rk i OS B IL{Eu &g 5 HE R TR 2 TR R R

o EIAHAILA OS HTAFu kAl ] A MR &AM ZA OS B T/Es,, nfLi3kfs PCS7 T
TR E s ] . I8 W LU ] WinCC/Redundancy #4470 A - E A OS BA T4k .

o AT UIAERA PC R AE o s T AR5 TRk &5 548 H -
HRWTEBMELZEE, A% “AHaA PC EH S TR AERE Rl (iR 19) 7

Higne
o I AIERA PC R Sl T AR 5 TRUME A A shib RE LS A e — A . Aoy 2
it SIMATIC PCS 7 BOX Siediit,

H 254
Engineering
Station
:‘ Terminal bus Industrial Ethernet
| =----- pm=-----------msso——smmo-eoo-eo--
‘ (OF)
b Single

|. MM | Station

( Plant bus Industrial Ethernet ] //-_//g

Industrial

OS B T{EuH PCS 7 OS Web #44

76 PCS 7 1, mILUM#H] Internet Explorer Kijjin] PCS 7 1.] [ OS, Hifes&Cifti%x OS %
47 PCS 7 OS Web 4 HAE M2 b 8 T 00 ZE 11y ) BB «

HXMEEAER, i /il PCS 7 OS Web Ui fii ] OS | (il 32) 7 #4%,

BEEZER
o “YrE/~ PC EAEG TRENMSFIEEAE oyl (hihd 19) 7 f4y
o IhRETM CdFifsilFR% PCS 7; SIMATIC PCS 7 BOX)
(Process Control System PCS 7; SIMATIC PCS 7 BOX)
PC 41 54
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PCS 7 #4519 PC 41T

2.7 B LIFG R I 5

2.7.2

BATCH B T{Eub

BA PC ARG A TAES R ETH) BATCH

28

BATCH H T /Euli 284 PC LY BATCH 3. 43l ERAE G IR W A0 I fe 4 ) i F #a g
i . BATCH P T {Euk 5 BATCH T H G R c/®ot) MHCE.

5 A S R GHEAT EOR TN 2 A b1t (OS MRS54%) (M.

BATCH S LRy nl T #AE I A L) M7 E 2 N R T, A R e
A A 2] OS k55 & AT ROERL I N BATCH F T Afnt . flRE M2 Dl R
7, VIR BATCH i % TAFuL R4 (hifih 22)

WEARAER T 24 BATCH L L4Fuk: Brli&EA BATCH S AR ui i JIERE ) 75— 4> OS

A LU A E BATCH B T 4Euk,
Jg TAEH A, A7 E S OS RS #iE .

OS clients
Engineering
Station LJ [ L ‘
L_‘n I I Terminal bus Industrial Ethernet
| )
redundant L ‘ BATCH
OS server OS server B | Single
i | |. Bl | Station
EL | ;_m:‘é-' \
( Plant bus Industrial Ethernet ] f//_é

Industrial
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PCS 7 Z4 119 PC 41 1F
2.7 W Eu5 R HIME T 5

273 BT I A TR

BAPC ARG B T AEu: R G BE A2 1l
o RARFEHIE AR A PC R EARTEHI TARR, . A A il TR Rk PCS 7 &
gerh ) JsURLRT A e A s 4K
o I LLTUARERAT AR TR B T ARl
o WTHERHE, ZORAATE OS MRkgs s MER.

L]
IR SRR AR P R A ol B L B A o) R 4 ) I A P O 5 SR () — AR G ) 4 % [X A
BT

2551
OS clients
Engineering
Station kJ_. | =} | __.LJ
:\| I I Terminal bus Industrial Ethernet
|- |
A
——— redundant | Route
OS server OS server B | Control
g |. MW | Single
LR [ gﬂ:);" | Station
[ Plant bus Industrial Ethernet ] /-//E
== Ind/ustrju-I
PC #7511
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PCS 7 Z4 119 PC 41 1F
2.7 W T EvE R IO %

2.7.4 %y TAEN S TAEW RS0

YE g B8 AR 4 TR,
o P TAEuE AT PCS7 L) 2Wifl PCS7 L] %r=& 2L PC ufi.

o VRN TS RGN LEY TAF Sl AT OS H TARuli A TRENuh K LhBE o

iy A= B
o CHFTIREZ TIERRS (L 24) 7 iy
o “OS M TAkuli | (JThg 27) 7 #sy
o “YERA PC_LALA TR ABRIE BOK| (R HY) 7 s
o [tk “ICIANATIAAS (A4 193) 7

o AT (LR RS PCS7; #ffl siuh)
(Process Control System PCS 7; Operator Station)

2.7.5 SIMATIC PCS 7 BOX 3

YER /MR S48 4 AS/ES/OS ] SIMATIC PCS 7 BOX 3

HAT & PREAFRC & AR 2224611 PCS 7 Box PC (illgE PC) wif PCS 7w HfE PC sk H3)
RS

X PCS 7 Box PC (4ilgk PC) W AT LA NALA:

o HHZhf: SIMATIC PCS 7 BOX i HA AS. ES H1 OS Jj#g ) SIMATIC PCS 7 5244 & 4;
— SIMATIC PCS 7 BOX 124 H A7 AS/ES/OS i) H TAE R 4¢

o HHZhtu: SIMATIC PCS 7 BOX {2 45 AS. ES A1 OS Jhfigft] SIMATIC PCS 7 i&1T R4
- HABM TR SIMATIC PCS 7 BOX
- PCS 7 M%) SIMATIC PCS 7 BOX

o HZR{u: SIMATIC PCS 7 AS RTX

— SIMATIC PCS 7 AS RTX /& MICROBOX PC - HA5 PLC WIinAC RTX % AE (1) 11 2h4k £
4 (AS, Automation System).
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PCS 7 Z4 119 PC 41 1F

2.7 W Eu5 R HIME T 5
g_E‘ALDS.gWJ
TEExRT SIMATIC PCS 7 BOX 14 HA AS/ES/OS Thfgdfdd: 74042 110 I TR, &
BN ElIR
SIMATIC PCS 7 BOX 416 24V DC
ES
|
I I
SIMATIC NET h
I ' é
Ethernet Ethernet
on board on board ]
........... —%) \
DP/PA Link
Du PROFIBUS DP/MPI
1
E .DDDDDDDD E
—
-I.El
—
PROFIBUS PA
| I |
S IEE
4 7
“:l.:l.:l.lJ _I
THfE R
iEA
A[{E ST PCS 7 H 3h %3] PC M4BT 415 B
M infE B
o  “RFFMIIVE R IR EIEA] (TR 113D 7 gy
o  “UIRPEEIAMPTHVE U] (RS 158) 7 #B4
o T (AFEFEHIZR Y PCS 7; SIMATIC PCS 7 BOX)
(Process Control System PCS 7; SIMATIC PCS 7 BOX)
o ISR SIMATIC: PCS 7 V7.0 SP1BOX416
o ISR SIMATIC: PCS 7 V7.0 SP1BOXRTX
o IS E SIMATIC: PCS 7 V7.0 SP1ASRTX
PC 414 54
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PCS 7 Z4 119 PC 4 1#
2.8 i PC Bk F e 7 %

2.8 Vil PC 3k B R T 5

2.8.1 f§iF] PCS 7 OS Web &I fE 5 in) OS

HT@ Vi OS i) PCS 7 OS Web 1

PCS 7 OS Web & 1] [l T-liL Intranet/Internet, {11 PCS 7 %} [ a4kt Bt 17484 b 1
A, AR SN ELER, WSETFM GIRRETRS PCS7; PCS 7 OS Web 1)
(Process Control System PCS 7; PCS 7 OS Web Opfion).

PCS 7 OS Web LI {45 LA T AN 4144

e PCS70S Web k%4
7. OS ', PCS 7 OS Web ik 55 4% H A7 PCS 7 OS Web JIk 552 Dihe ) OS % #l.

e PCS 7 Web & /Hl

PCS 7 Web % ' HL{&B) Internet Explorer, ifijd Intranet/Internet Skijj11] PCS 7 OS Web il
s L] I E 2l o T DA REREA T HR VR A AR

PCS 7 OS Web {4 1] LL/ERA FAI41251 PCS 7 R4 h Al :

o XIT OS Z IAEui R4
- Rl PCS 7 OS Web Jli55 &+l PCS 7 Web % /" HLIIZH 24

o X+ OS H L fEu
- RHI PCS 7 OS Web hrifiilR % %1 PCS 7 Web #rufl % S HLAAL A
- KH PCS 7 OS Web 2Ii/lk 554 Hl PCS 7 Web 2 Wi % P HLIIZH A
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2.8 11 PC I HIE AT
g_E‘ALDg.ng
FE A PCS 7 OS Web 45 #3F1 PCS 7 Web 5 HLIK 2245 512451
FCS 7Wieb client
e
S
AT T
\ |rtranetiinternet )
S
25 client 25 client 05 clignts
FCS 705 Weh server
|| | |
. — e Terminal bus
Engineering 05 senver 05 server
Station (ES) | |
_J I I k
|- |l ) —
—|—1 Flant bus
“Il | Automation system (AS)
kil |
PC 414584
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2.8 i PC Bk F e 7 %

FHK PCS 7 OS Web %2551 Web % P HLEE EE I
o T 0S £ TAEH R4

- B4 PCS 7 OS Web flis54:) OS = P HIANGERHIAE PCS 7 RETH K#RAE fist (OS
HHL .

— B OS Web RZ5231 Web 2 P HLR B KRR 24 il IR FIRR T G40 3. 10, 25 3§
50 > Web %/ HL) .

o % T OS ¥ T I

- CAAN PCS 7 0S Web fIkR55-# 1) OS B AR {E PCS 7 L) Hhyn] FAEHRAE LR
(OS, Operating Station).

— OS P ILfEuh (2 OS Web Ii454%) wZ AT 3 6 Web % ML A EE
- Web 2% A ¥l 2 AT [R5 ] 3 4> OS H T AERE (OS Web 2 Wi RS #8) %
o Web &/ ML) E NEE 4 rl I 2 R IR & .

b hnf= &

o HRLRMELR, WSHTN (LRSI RS PCS7; PCS7 0S Web ()
(Process Control System PCS 7; PCS 7 OS Web Option) .
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PCS 7 #4119 PC 21
2.8 i JH PC Bk fF e 7 %

282  {#F Open PCS 7 V)il PCS 7 %iE

Open PCS 7

7£ HA4 Open PCS 7 [ PC 35 (Open PCS 7 i) I, {#i}l OLE DB 1 OPC n:¢f PCS 7 L]~
(KBRS 5B =T RGAE T .

HLAAERL 5348 H] Open PCS 7:
* HahfbaEg

o LRI P A

® MES %52 (il AT &40

® ERP %520 (kBRI

Open PCS 7 W4 %
Open PCS 7 i j& 22 T OPC #1 OLE/DB JI %% #%1%) PC.

Open PCS 7 3 n] 04T LA FAT5%:

o HREAI{E OPC 2 3R A s Ll #E i) PCS 7 #idfii .

o YAVFEFHUNHF (OPC i OLE DB) jinl nfHIf¥) PCS 7 #idli.

Open PCS 7 sl i £ i M 2% H: 5] PCS 7 L) .

FER TR, Open PCS 7 ufidliid #:4F f1ut (OS JIkg5+s) 5 Ak REEHEATIE .
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2.8 Uil PC Bk iF e 7 %

H LB
R8T FIH Open PCS 7 HEAT [t R 4H .

® @ ®
PC with PC with Open PCS 7
Client Application Client Application  Station
e e
| | m| )

Open PCS 7 Station

- e Internet/Intranet Internet/Intranet
Client Application
OSclient | Open PCS 7 Station | Firewall
T (or + OS client) T bl Ty
Terminal bus I Terminal bus I Terminal bus
|
L 1,08 server L JII __|,0s server |JI L |l OS server
. .
( Plant bus ] [ Plant bus ] ( Plant bus ]
| | |
[ iﬂlm Automation il [ Automation il Automation
IL system |||| system system
WS | A I FH AT
1 Open PCS 7 iifi. OS & HLAIZ P HUNHELF (OPC | S AR R4
2 OLE/DB) {13t PC L B TN RS

2 |OpenPCS 7 utifi  USTIFLF (OPC 8¢ OLE/DB) | SRI%/ Hl-Mk s o th R4k HaNy & LA
BT FA PC I, 3kt PC QLIS (k| HAT:

1] Intranet/Internet) 3/H47i44% RURTRFERSR

# TUL4LA, Open PCS 7 i bl 22445 OS %/ L L.

3 Open PCS 7 3ifi% S HLW LR (OPC B OLE/DB) | SR % S WL-JIR 4 Sk R g5 M 2 T4
BT PC E, iXU6 PC LB ML (Bt | 3R %

f¥) Intranet/Internet) WEATHEHE; T BHINI S, A2y | EBUH T KPR R 4

KIS PCS 7 T [ sk

CGab INVAZEY s N v X W v S w i LTI B
P LN F AR Pl i e 15 W) Open PCS 7 3 B[4
e Open PCS 7 fifi [l T Zlhntkd 1k X EA T 2o 18
e OPC DA CH#Eijjin)
e OPC A&E (REFNFAFLL Ay s E R AT )
e OPC HDA (JJj s %#i vjj 1))
e OLE/DB (3 ff OLE KN JIRER (4 MS Office) 1 EH F2 i)

ARIETFENEZEE, ISHEUSTN GEREHIRSE PCS 7; TR
(Process Control System PCS 7; Engineering Station) .
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PCS 7 #4119 PC 21
2.8 i JH PC Bk fF e 7 %

Ui R TUAR IR 5 235 I diE
" {1} Open PCS 7 iV W JUARNR S 0 Pl . sk PC o CEsb) UM, K A shik
FIUAR PC s LAEAT N — IR,

L SRR Y I A R 4 P K, Open PCS 7 32 248 WU A Ak P 15 B Kl

R AT LAV iRV BT BT R BV AT 3
it Open PCS 7 Vil PCS 7 %iudfa i ity 2 AL LA AT VP nl ik 91 2 F -

o IR “OpenPCS 7/WIinCC” ¥ riEZ 4 I+4E OS &l L1 Open PCS 7 i, OS
LA T B R .

o A “OpenPCS 7”7 VFnliE%4], nLMGZH T Open PCS 7 Vil PCS 7 i .

BZER
o AT CFEd RS PCS7; TR
(Process Control System PCS 7; Engineering Station)
o AT (FEHI RS PCS7; #fl fuk)
(Process Control System PCS 7; Operator Station)
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2.9 % #% PC 4%

2.9 % PC i

2.9.1 AS. OS. BATCH. RCS #1 ES 2 [A] ] B2k iZ#E

B BRI Bk

FIFH PCS7, AS. OS. BATCH. Hfafsihlfl ES shvlilid Mk R4 CTAVLURM) ST .
fEPCS 7, XRLRGMRIDUIT:

B FAT DU 2442 1) (1 T8 R
Ly 5 2% o FAEMMMLARS (OS. BATCH. stz
o TR,
o EALE (BN, MES. HAEMZ)
T B o JR%2% (OS. BfRiEdD AL RS
o HAIMMLARS (SIMATIC #EH)

A
Domain
Controller BATCH clients OS clients MES, Office
- networks
I’ I
—
I I R
I I I I I Terminal bus Industrial Ethernet
Engineering MS redundant Route Control BATCH
Station with MS | server OS server Single station server
client I
. DRl BEs~—r Ay L
- .| —
LR \
I .
1 - ]
1 Plant bus Industrial Ethernet //'-//g
1 [ I ] == Im{s:;w
T I | |
|
. e igl!m ||| EEE Hﬂﬁiﬂlﬂ
-, .| 1AL 1114 1
Engineering SIMATIC Automation system Automation system
Station PCS 7 BOX AS 400 AS 400H
BZER

HETM CEFfEhl R4 PCS 7, TR (Process Control System PCS 7, Engineering
o LRI L1
® PCS7 1) H&AIFZI s

PC 214 54%#
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PCS 7 ZZ19 PC 41T
2.9 %% PC 1

292 BERB AN NI Bk

OS. BATCH. ##2#=HIF1 ES ME

AR RR A Bt . BATCH 3l AR T AR S AT TREI SR 2 T LUK K . Sl IR
] PC s fe it % (PG) H AOIEAMEMG . AT ZRAE AN [ A R R

B nfE B
RN AR EIE, T2 “H R 2/ T R4 (vihd 49) 7 fB4r.
H 254
PC Station
u_ | \
\ I Network module
[ Industrial Ethernet l - //'_//_ég
iHIg “l Automation system
CP 4431
E#AS
{EH] CP 443-1 il iHAL B3 5 CPU LUK LT, i F SR GEIEHE S T LUK I o A8 B
BH TCP/IP. 1SO #i1 UDP,
PC #7511
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PCS 7 #4119 PC A1F

2.9 F# PC 3%

FL A Y 2% 4 1

TLRBLERR

ARETERER, ISEAST GEFE6 RS PCS 7, TRUmR)
(Process Control System PCS 7, Engineering Station):

o HLZRI N 45 2 1

e PCS7 1) NI RerE &

A[LIfE PCS 7 A UAY IR 2. ARt BN S, w&% (PCS7 Thit Tt 24
PEHIRE) (PCS 7 Function Manual; Fault-Tolerant Process Control Systems).

293 T Jogk LAN 3% PC uf

it TR LAN (IWLAN, Industrial Wireless LAN) #3# PC 3

Tl T2k LAN (IWLAN, Industrial Wireless LAN) A& n] LGB RE PCS 7 1) Al il s KA %
Bhok i PC . nl4ERLL T PC ¥
e OS %/l

% 21 08 &/l GERE] IWLAND

o Web %/l
% 2 MiEH:3| PCS 7 Web JR55%511) Web & HL (GEH:F] IWLAN)
e PC ik
Bihn, WRWAE, T NetMeeting Bz f s e B i) T REIT 2, () 4> PC 2

PCS 7 # F-F IWLAN Fj4H 14

40

(PCS 7 - C.kAitbitk) (PCS 7 - Released Modules) S0 k4%1H 7 PCS 7 v S T+ IWLAN
I 5 F1 PC 414t

A LA7E PCS 7 Toolset DVD - 4RF1Z 30k, 8ifE % PCS 7 Jolid g i 4 “FFiR”
(Start) > SIMATIC > “3C#4” (Documentation) > <ifi 5> > “PCS 7 - LA fifkiik” (PCS 7
- Released Modules) % #i% 4%,

PC Al 54%
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PCS 7 ZZ19 PC 41T

2.9 F# PC 7%

PCS 7 & IWLAN [f15245)

B A B

PC A5

NEERT PCS7 L] WLAN A EEALLZ

Remote access to OS Client or
Engineering Station Web Client
[ Qn —]|

NC
e

[@] Access Point
= (WLAN)

Engineering OS- / Route Control Clients ~ BATCH Clients

Stati
e o ke ek
C—_ d |

2 | | | |Termina| Bus Industrial Ethernet
\ OS / Route =l Redundant-
| ||| Control Server |, | —=— BATCH Server
—— —

]
[ Plant Bus Industrial Ethernet ] //'-//

17k WLAN 410 2R M DL BEE IR R, 152 B LR SOR:

o AEE (dFEHIRL PCS7: PCS7 - LR
(Process Control System PCS 7; PCS 7 - Released Modules)

o RZT (SIMATIC NET; JEfit - Tak G4 LAN)
(SIMATIC NET, Basics - Industrial Wireless LAN)

o PAEULI SIMATIC NET,
SCALANCE W788-1PRO (il i) ,
SCALANCE W788-2PRO (Xiijif ) ,
SCALANCE W788-1RR (il iPCF)
SCALANCE W788-2RR (X{iy i i iPCF)

EeEU (SIMATIC NET; CP 7515)
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PCS 7 #4519 PC 211

2.9 F# PC 3%

29.4 H b0 [E 25

i i8] [ 22
EE R R R G, B M T i 1] A 5 AN A0 EL A5 AR 8] H SRR ) fs H B
UK SIMATIC 414EF1E PCS 7 1) HyisA] b (f4n SICLOCK TM) &
TEBAN RS T HE B

D ERICAT AP IR R, SRR R AR SR AT AL ot 2 IR TR (0 I B DA o XA fmT
iR T Q1 L0 2 U TRRYE DS N PS T A7 2 U PR Va1 DS NI AT Wi TR d B L R B T/

ik, OS R #sKAH I [ 5 shae (LA B o A, TJ Rk bie pra 4k i
Sl A B A R GE AR L AT MAZEHS 1] 2 3t B2 P A 1] R T
IS RGPS S R0 N
o Ui gk
OS k%5 #v il i Zeui i 2k [7)28 OS & P Hl. it BATCH FlEs AR5 ] A ulhi R e e e HA
OS iy PC £, Ml % WU (DCF77) W& M2k 343 /] . #F Windows f5H1,
A ) K H IR R 26 20 > 1 FHAE B ] 25k OS kg4t
o [ Mg
OS Jlr&s-#siliid T) BRI Aotk 7% .

PC 214 54%#
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PCS 7 ZZ19 PC 41T

IRl 25 3 T

2.9 F# PC 7%

]

[0 IR

BHinfE 8

S (FAb
il
Y T AE

o I A S R D N )
o T g RIDIN T

MAETM ISR RS PCS7; #
i Bk

BATCH i

o JHIERAE RGN DI ]

ff R RGBT RS
SIMATIC BATCH 41t

HAR P AR

o JHR ARG DI ]

A AR AE R G DR U5 ) 20 B A P AR
w4

SIMATIC PCS 7 BOX

o (EHERZF PCS 7 1) HilE [R5 W fa)

T G Ref= R4 PCS 7:
SIMATIC PCS 7 BOX)

AS

o il AS [FIH: ]
o [ FVE I A MUK AS [ 25 B )

NERTN GIREFEHIRS PCS7; T
FENTI3 )

I

o A i Sk AR DA I ) 3l PR
PR IR0 I R

METN (LPHEHI RS PCS 7
A Gt

P[] 3

o IHIEEHEERAE PC 1, siE RN
IS HiREBEEr SilDY TR

o IR AT LR AElSIHIT LUK &I%
IRV S FUEAT R (94 PCD

AT GEREfERIRSE PCST; #
PR B
T (SIMATIC NET; SICLOCK TM)

PC A5
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PCS 7 #4119 PC A1F

2.9 F# PC 3%

PC 214 54%#
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PC 3 F# 3

3.1 PCS 7 ITiZA PC &4 (P E)

AT+ Mm% (ES, Engineering Stations) F1#:/E 5iut (OS, Operator Stations) [ PC 14

CVEFREAH I 1) W B e AT I DA TR R R FBOAS (R JEAE A =i E) , wT TRt (ES,
Engineering Stations) Fl##4F i (OS, Operator Stations).

FE2491T ST PCS 7 HskfoCH R “HABR %" T rlk2Ift PCS 7 I Ti4ld PC R 4¢.

A PCS 7 BOX PC HI T PCS 7 W4 i ffy /NN, RSl 4 45 (1) AS/OS 3 o
AR TEIEZER, IS5 FM GdFHEH R4 PCS 7; SIMATIC BOX)
(Process Control System PCS 7; SIMATIC BOX).

WAK e PC HI T PCS 7, AlfE “HLFEAMEAFAC S (Uil 460 7 Fli7r BN KA1

LR

Fa s
K4 LB BRI 44, Siemens TMVISHR 2L AT HI/E PCS 7 it Rl vl ae,

FEVE AR %0 1280 x 1024 FMEAL S, XKL AR A PCS 7 B ALK
TR

BTASH PC REIEBERIM%
FTfi PCS 7 3 PC )& X—/~ Windows TAE4L M.

W 2RAE Windows S A A1) PC #48, MIAZGERE PCS 7 22 My BBl 2 42 B .
ARLEWENEZER, WE% W EPEE PCS 7 (23 E| (U4 139) 7 #7).

FEZED-)
e [ STPCS7

e [{3t STPCS 7.1 (SIMATIC PCS 7 I}

PC 4l 4152
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PC 51191 T

3.2 LM A&

3.2 NI CS AN

o
ESHZ

BEARAIEA AR PC B
EAE IR FEARE e

o IRARIEAMEMILE

RN EAE I E

EBE LU N ECE K PC 41 GRS BTl my ) -

Eg&%ﬁ&ﬁ%%%qﬂﬁiﬁﬂﬂﬁﬁ, R FRAR | OS &L,

BATCH &/ #1,
PC _L# PCS 7 OS/SIMATIC BATCH/SIMATIC | 4247385 £ 4l

B,
AR,

OS k%28,

OS # T HEv,

Y TAEN,

PC ki PCS 7 Web li%&%%. OS Z LA
BATCH %/ Hl,
BATCH k4548,
BATCH # T k3,
BRI HIRS 2
P 2t . TS

SR PC (ZUHFO

SIMATIC Rack PC 547B

AbERRR

Intel Core2Duo E6600

b Pk e A 2% 2.40 GHz
CRGRAT 4 MB
(SLC, Second-level Cache)
T S 28 1066 MHz
(FSB, Front-side Bus)
TAEAik 45 (RAM) 2.0 GB 1.0GB
T £ 250 GB SATA RAID 1 [, 250 GB SATA
FH T R45 85 A1 ES/OS H T ARHG
250 GB SATA, HIAER M HLRSGH
3 XK C:\ 50 GB C:\ 50 GB
X 8% 3 T i /1 TR

o FH T2ty s R 1
o T Rk

o RJ45 T IRALLLK I
o JHT LANEA OS s 41t CP1613 A2 2 | RJ45 M T-IBAL LUK M
BCE MG ALt

SR o T FRR AR LLANK BT B 4% DVD-ROM DV
DVD-ROM
o X LARITu,:
DVD+/-RW
PC 214 54%#
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PC 551191 1

3.2 TR MEF A
¥ SIMATIC BOX PC 627B SIMATIC Microbox PC 427B
IbFH 2 Intel Core2Duo Mobile T7400 Pentium Mobile M738
BBl ik e A 2 2.16 GHz 1.4 GHz
TR 4 MB 2 MB
(SLC, Second-level Cache)
I B 2k 667 MHz 400 MHz
(FSB, Front-side Bus)
T ARk o (RAM) 2.0GB 1.0 GB
il 160 GB SATA BEMNAFR: 20GB
AEWNUN C:\ 30 GB
oA 5% 335 T % /30 T o 24~ RJ45 HEFILAL LK M o 2/ RJA5 REFIEALLIKM
o H# CP5611 e H# CP5611
e 7E “SIMATIC PCS 7 BOX RTX” fit,
k4 mit CP5613 A2

K DVD-ROM
FEME TS

BiEd

TEEE R LR 0

o XTZIWHIAE, WMRMEAPK PC BAGEBBHGINR. K& E TG AR DL A S

IRSNEE, Bt ARG IR A A .

o R P R TRY RS SRS SR SR, #iUE A PCS 7 Mtk H X RS SRS 4 .

PC 4175 54240
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PC 5 HIm 1

3.2 BRI &
BREAE AL E
PO VAN CRT TS I E SN QIVAT Pt D WS FZ AL
¥ %ﬁgﬁ%ﬁ%ﬁﬁ?%&@ R | TRENTYE, 0S & F#l, SIMATIC PCS 7 BOX 416
o OS M54, BATCH (34 PC 4450
RIS %, OS BT 1Eu, &/ B BO%(ZI;C 627 ;i%?&
PC L PCS 7 OS/SIMATIC | 4y o - s Eﬁﬁ"“ W)
BATCH/SIMATIC #4532 PCS 7 Web
AR%-2%,
PC 1:f OS &/ HlL
F1 BATCH Z /7 #1,
BATCH fR4-#%,
BATCH H T k3,
BRERIRS S,
AR 4 ] B T AE S
L SLIE R Intel Pentium IV Intel Pentium IV Intel Pentium IV Pentium Mobile
IRt ik A 4 >=2.0 GHz >=2.0 GHz >=2.0 GHz >=2.0 GHz
T >= 120 GB >= 120 GB >= 80 GB 80 GB
/N RN
C:\ 20 GB C:\ 20 GB C:\ 20 GB C:\ 20 GB
AR (RAM) 2GB 1GB 512 MB 1GB

0 2% T 4/ U TR 1D
o T BLIEIN

o RU45 ERAT CPUELUKM)

o RJ45 i&EE

o RJ45 #H;

BOX PC 627 15 2 4
RJ45 A CPUm LUK

o FATL) BLWI |o T TRITHA OS s CHRIE AR e COUELL ) et )
ft) CP1613 1, BCE %515 T LR AR
" 0OS k42510
it 2%
CP1613 =, BCE
2403 i %
oK DVD-ROM DVD-ROM DVD-ROM DVD-ROM

PCS 7 B3 &R B

45 PCS 7 Toolset DVD [/ pes7-readme U145 A48 PCS 7 ARSI
B .

EZ P

48

Hsx STPCS 7

H3% STPCS 7.1 (SIMATIC PCS 7 ¥

PC 412 5%
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PC 551191 1

3.3 TR/ 1) b 2E T TF

3.3 &g/ T RErast

OS. BATCH. E#2#&#IF1 ES MiEH:
LS T A LU R PC sz B Tl LAY «
o AR B
e BATCH u}
o ERBYEE T A
o LRI
BT 2 PC oRGmAL B (PG) P KA . AR 7 S0 P 4% b RS .
o TP R
- bRUEEAELER (B, & APLIERCES Intel Pro/1000GT)
— PC 3 B4 MR IN TUAE B
AU FLE— G PC T AR A 9 44 55 1 e

- Intel Pro/1000MT Ji 45 %8 i ic' 2%
- Intel Pro/1000GT & U HLIE it 2%

o HUAEH] PG RC Ak IER L) B M HA 8 Mliikt: (ARG 4
A I -

— Intel Pro/1000GT & A HLIE ld 2%

o UIREMEME MR E 8 NN HIMLRGIEA, BUSK AN AL RGUERR T Kk, W
AP AT AR FE A R T A S5 <

— 35 S7-1613 HAFH) CP 1613
- BT IH S7-400H/FH #EATITUAEIHIK) S7 REDCONNECT #{4:1#) CP 1613

LA
f{H CP 1613 n[ L5 £ 1k 64 M AFL RS (WIITRRYG) drilif.

T) Bk ERIBT Kbk

WRAET) Bk ARG KBS, WFEER FHE2EM 2 —1) CP 443-1 il AL BES:H T
SIMATIC 3f;:

o [fjkBERA N V2.5.5 55 1K) CP 443-1 EX 10
o [ kBEIRA K V2.5.5 5L =i CP 443-1 EX 11
e CP443-1EX20

PC 4l 4152
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PC 51191 T

3.3 TR G/ 1) w29 TF

WA

PCS 7 Toolset DVD e fitf5 il T LIl il IR s e Fe . AR EEIIEZER, T2
% “PCS 7 MM s AR ahfE | (5ihs 103) 7 #Jr.

SEREZiCi.

CP 1613 SCFr T LURM (PRIEDUKM)D B HE2EE . i CP 1613 (1) PC n] LA R I
V] A 326 7 F2 WAL I ) o «

e [iiff CP 443-1 [f] SIMATIC S7-400/H/FH

o JH T TMEUKMIF) SIMATIC NET INf[i] 4 1% 2%
(HRER, W WHZ IKPD

e SIMATIC SICLOCK
e Jitfy CP 1613 [ PC

PC 214 54%#
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PC 51191 T

3.4

ik

EZER

PC A5

3.4 o EHIBEF A1
A% R 2 1

Eikia oA

AR PR E TS F R PC 3. SEMREUR P i — NS H R
B RS T SR AT ORI USB B
TEE: WAEH] SIMATIC Logon, 5 H R IR L 33 04203 R AT TCOS 2.0 4:4E &
G
OMNIKEY CardMan 3121 USB its < [5] 5:4% B 75 (¥ 2k sh 2 4
PCS 7 Toolset DVD _E [ R 41 S04
\Additional_Products\Drivers\CHIPCARD\CardMan 3121 USB

FTEIHL Yy A B AT EN D) e 4T ERPLEAT XA EDHLAH 4T EDV P HR s o B RS
S FEFT B

B SRR A DU R A S A ek b i = A MG RS 35 5 R L. 78 WInCC “ b & 5 i
&7 AT, NIXEAME S RN AR . iR AR R 17,
WS A5 S B AR AT 5 RSB
15 5 RIS LB 73 R Bl AR 5 B B AR A i DA EA T A A
SRR I TAUE S . X EAME S RIL — R R AL S, 1%
R o AT LA 7 A S R AL
Hi T HA WA DI RE, R S ROE nl AT B AR A hR 1 o

BR AU RRHAE S R R OS P TAEN R4/ OS %) Kl TRl 5 S8, wLi#
AR s BRI REHCCE Bl *wav) .

Tolk B WA EH TR PC 5T B4k,

ARZERIERIT | WRFE, R AN %24 PC#IERIT (MHF) , FER{E 750 m
LA 1 Xk 2 AT L

Multi-VGA £ TEFVELL R 3k B2 0L PC 2238 multi-VGA BB R
o LRI, ER
o IRMERNEHLEK SIMATIC B4zl % L
KRR AE— & PC OB WAL ARG 2k 4 G ss.

EPROM 2% & | XHFLTIXT SIMATIC £k F1 EPROM ML T4 FE .

USB #rfeas

TLAR M LR TG L% KFERT LUK PC Sl He 31 U A ity S 2%

® Hxx STPCS7

EAETF, 2007 4F 9 Hhi, ASE01235050-02
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PC 51191 T

3.5 H &A1Y

3.5 HAMIT

ATPA

RALERS

R SR HRTTE

52

TE LA H R CAOT: F3)it5 %) CD _ERRHTAZSHA, ZHAHEQIE PC MM AT RE&
RATH -

RN PC A SAASEATIWE R, WB% W FE15# 7% PCS 7, STPCS 7 H %
P T e B 2R R TT 5, AER RN o R A L4

Wik PC 24 (Bltn, RAID &4 FEHE XMRTE, EHL 24 Siemens fAHEL R,
W AE T M hE R B 24 1K) Siemens AR

http://www.siemens.com/automation/partner

PC Al 54%
EAETF I, 2007 4F 9 JIh, ASE01235050-02
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7% PC

4.1 A FEMA

k]
e PO R TH R B SRR o PCS 7 2225 PC 35 FT K 03 AE TR A .
Siemens A FISIE T PC AL B0 7 IR IIRRL. #7060 RIS B, IR I s
st gk

272 BIR
MR A 20 LI 25 AR 45 AT I

SB s

RS

1 TIEEAE RS (TS B1)

LRBAE RS RS (Y 84D

BCE HRAFAEAS ORI A ] (5T 85)

2

3

4 T RS E (T 66)

5 o %24 Windows XP Professional (1134 L EAS RS (TU65 68)
o [ Z23E Windows Server 2003 [17H L EAFI RS (1ihd 89)

6 ‘%%é Microsoft SQL k425 (Uihd 71)

7 TR IMALE (TR 70D

8 AR IR B A A IR A5 DA (T 74D
9 ‘%% SIMATIC BATCH ikt ks (5ihd 75)
10 BCE UL AR RN (TThS 76)

1 Ao R 77)

PC 414 5L
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& H PC 7f

4.1 ZHALFEL

BB | mz

Z$ PCS7

12 T4 PCS 7 #AH (Tihd 82D

13 A YL R AR 25 4% (StoragePlus) (T 86)
14 MHILRIRFAARICR (T 88)

15 1 PCS 7 OS Web #t1jizd PC (it 88)
16 s PC ki B kRS (TUHS 92)

17 G DR TR PCS 7 fk 5 B8 (TS 95)
18 AT B 2 SR (RS 96)

19 VERT FI#Z4L PCS 7 # 48 (Tihd 108)

20 HE#: PC i (HEIAD | (TU1H 126D

21 Gl Ay (iR 77)

R4 PCS 7 %4 HE

7E PCS 7 235t fi b & B sl SIMATIC 2 4¥% 14 (SSC, SIMATIC Security Control).
SIMATIC 4 FH P AT TG b 7511 PC 3l 22 A s

54

PC Al 54%
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2k PC 1%

4.2

ReiE 5 X

PC 4l 51

B X

N T IR &y, Nk PC AL )k Rk 4y X

o JHTHAERSM PCS7 &d%: #20GB
* JIT PCS7HiH4H: it 15 GB, mHEAT LA IX

Fn B S AR BAEN PC BRE A A& A W I AN 52 3 5% i (1K) B A7 i o L
#11 CD. MOD. J3& M4

o Tt

4.2 B 71X

120 GB fili# fr) sz 49 -
BqRF K/ (GB) | EEha& &K | Atk A%
20 SYSTEM NTFS PR RS M PCS 7 2%k
60 DATA NTFS PCS 7 il H $d
BACKUP |NTFS B S
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& H PC 7f

4.3 LIRS

4.3 ZIRBANERGE

4.3.1 ZERERAERFI

FE M 28 B A

56

SAEA NSRS N A W DU R g LIRSS 48D UM% .

EM AN PCS 7 1) PC ufie 1R LT JLAi:

Bi

ARz PC o, ol PC 323 TARLL o AT b SRR G 20 4 g sk R sk, (97 1k BELAS
2he

WH2)4E PCS 7t LU PC i HI T B (a1, DHCP 8¢ DNS JIR454%) -

o OS 5543

e BATCH fR45%%

o BRTRPEHIRS HE

WERFA RS % (OS JIjRS5a%. BATCH ko5, BARIEHIIRSS &%) IEHIEIX SRS 1R 5545 »
W PCS 7 Wil G238 PC Wi i 52 25 .

el

N
*

HAEAE PC i LA TR A 1) PCS 7 AT/ e x5 T HSEE ] Tl B ) PC b
(OS. SIMATIC BATCH. SIMATIC &4 #H)) , H ik,

LRI FIINEIE R 2 Siemens AT IIN IR 2% PCS 7 R GENERE™ A= AFI 5L o

A =057 7N A AT R4 S A

R TG B =7, WINAE 23 PCS 7 Z A &AeiX ;= i, PCS 7 HIXLLLE —J5 77
ANBERIN AT .

PC Al 54%
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LR PC I
4.3 LR F S

TERLL AT R A0 — 5 S

TR

W

o IR PC ¥ Bk %3 PCS 7 MM RS, W HM %% PCo X T2 it R4

o PATHr e AUk AP M. EE ARG R, W B AT pes7-readme.

o BB

o HREZ FPORAFAE ST HASCI (i, LRAFRIMER D o HEMKER, WS%
SIMATIC Tt i Fedziil R4 PCS 75 IR55 SCREAIIZ )
(Process Control System PCS 7, Service Support and Diagnostics).

o NHFTHAEIER . HEMALELE, USE TN GIREHIRS PCS 7; WA
(Process Control System PCS 7; Software Update) .

o R IEAT AT ST B K .

o g ARAE AR T BUEBT 71X

BERS
AL RIAN R () 32 A7 #84E R G A7 Fr AN[A] -
e Windows XP Professional 14355 5§
e Windows Server 2003 ()25 5§

7£ PCS 7 ] MR E R G LT MR MSE R, WS BRI E R VE Al
=Yl (158> 7 .

ViEH

Al DL N R RGO R A A i 4
e Windows Server 2003

e Windows 2000 Server

PC & 544
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& H PC 7f

4.3 LIRS

BIERAKKIES

PC &

58

I 412 R R BR3P G B
o iy

. i

o YEif

o i

o RO

o VBT

PCS 7 il PC BFIT % ¥ el 4.

U ET 2225 PO, AR/ BEBRA R o5 IR LA F S5O

o IR PC UM —H R, U EAL A L R BT (3R R A

o IR PC MMM ZMIES, WEHEZIESTHRMERSE GUENENET) , RN n
2 i = M Sl

WARBAE ] FRIZ. 0, ] StoragePlus WebViewer i 1a) ¥ i nf G2 L) . nf LA

& Windows #= AR [t “ &4:” (System) R “IHHLAF” (Computer Name) i+ |

#3 PC 45K

TEAHAS OS B BATCH JIR45ds LU TR I, 15V ER, PC b AR 5 k%S 4 PC 44 FK
CHENLAARRD M, X m R EE,

Bilah: FERCEYE TARRN GEZ W CEREH RS PCS 7 #:4E b 4T

(Process Control System PCS 7; Operafor Station Configuration Manual)) .

AR EHNEZEL, AIS% “WIinCC 5B RS (WinCC information system) > “ A3 1

2 S/

H” (Working with projects) > “[ff%” (Appendix) > “Joxi 4" (Invalid characters).

PC Al 54%
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Z2F PC 5ff

4.3.2

faifr

WAL

W 2%

PC K %EWE

PC 4l 51

4.3 R T

PC A& %2R E

METIAE AT E H 0 T SRR BRI R G 1T ARG & 3o T0Re 2 ) 9 234 3 A JL g 4%
W1 B e 1 fe k. R, 5 B RGRIN S e Al T R E i Rl R G N 32, YERf
TR IR PR AR SRR A TR 9 1 I X 2 S

W RE PCS 7 PC w3 PC P45, ) FE 41 5475 2 Microsoft Windows [’ 45 #1401

T GIREEGIRSG PCS 7 W MEMES PCS 7; g iSUMIE a4 0)
(Process Control System PCS 7; Security Concept PCS 7; Recommendations and Nofes)
B T8 B ORI FNALZS PC 25

o IZ TR THEEHUANT A BELL R PCS 7 Hp P A5 ) AR PR BEIEA T A
o RRNBIRMAT K PCS 7 MZEAL A E] Windows 7 BELR ST A HE EE B
o RO THEEIAE PCS 7 L) R MBI A H] T H Nl R

o MRIGHIA LW PCS 7 L) IIPIAS PC i [H) 7 A AN 7 BRI 22 4 3dl TR A2 10
fr.

il
AF ML Windows XP Professional I Windows Server 2003 it a] JH i 15 4 JEmt, IFH.
SR LA WA R4S PR IX Se A RS HR

WAL AT L B A B OCKE 2 PCS 7 LT HIM%s, DAFCRAT (T AT i e g ) PCS 7
T (B, IR A

2R PCS 7 I, WAEZRENAE PC LR T 2 e, o LU s R 2w E .

R
MU A PCS 7 T I, BB (%A B T A B, S B R % A
BT UM
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TR B PP A EE
FIAELL WA T T PCS 7 I RE 4Ry M BT

TEE
ER, AN SSRERE ) PC, M GVEE R P kAT 228

ARULERENEZHER, 2%

“nf s PCS 7 [ A (UURY 139) 7 #R4)

Ve UMM . IEAMEF AR (if 138) 7 FRar
AR RPN E R E L E L, 2%,
- “DNERHOREAERS (Y 146) 7 oy

R VEBAMER . MEAMERS . RS (DAY 138) 7 iy

Tl G FEafI RS PCS 7; 2Ll PCS 7; A SCHIVE S 4+
(Process Control System PCS 7; Security Concept PCS 7; Recommendations and Nofes)

XA pes7-readme

PC 214 54%#
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4.3 LR F S

4.3.3 A 223 Windows XP 1 Windows Server 2003

L3N
PC b C 2 e A b 7 IR A BE 75

P&

B
X2 T 2, EHENAIRS SR iE S “[..]7 W

—_

. 1t CD X&) i NERAE RS0 24 CD.

G 2 he d) PR RARAERGE

. AE “IXEAIE ST (Regional and Language Options) Wil HE 415 BAA R GE kAT R .
. AE “MMEAEKA:” (Personalize Your Software) A& HE 0 AR RG AT IR E -

A TS (Product Key) SHEHEH I ™ i % 81, W 7E CD BLARAE FR 3™ W% 8.

CRIRUBER” WHFHHESR B4 Windows Server 2003 1 Windows Advanced Server 2003
(2R (FF Windows XP (12235 F B A S I

PR BN BEE Ny “HEIRSS A7 (per server).

MR AR RS SEE &, E BTG, WA VFA B RS A slih
FJ'” (per device or per user) .3k %4 .

SR/ TRV N 0 R = TN B (B 7 W1

o o A W N

LBl
—/MrE Windows 2003 Server A AL S w4t FANE P WL VAT e . R IIA 2 0%
BB IV ATHIE

7. 1F “THENLA M 5195697 (Computer Name and Administrator Password) i 1 AE H 4t %o
ARG AT R E

L]

WL ERERIRL R R VE T LA FR, XL PR R4 PC 7R A R ZAERINA
KIF B

TSR PR R REAE ] 7 RPN

8. 1 “HWIFIH ¥ E” (Date and Time Settings) XJ il AE 41 % HAK R G AT REHE

PC & 544
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62

9. WALENERBEGAE “ M E” (Network Settings) X i HE EA T ¥ &

1078 “TAEHEGHAHIER” (Workgroup or Computer Domain) X 1 HE R 416 HAK R G T B
W AT LS AT I 2

LR
SORE T SR R S A
1. BN iR CD LI s
2. WA B R AT 22

3. 1 “Windows £ i& 5 H /' At ” (Windows Multilingual User Interface Pack) % i HEH,
EPE TR A IR HE A 05 (IR ZAES) o ERBIAMES . &P “UUhtdE
Unicode [1Ji&5...” (Match Language for non-Unicode ...) Al “JCEZERIA shell F25%...”
(Match the default shell ...) ZIEHE.

4. TEAGLRFET UL T 2%

5. HHHz) PC.

Windows %% & I i B &5 e UG

PTG vE oA TE

1. PSR4 “TFEE” (Start) > “#E” (Settings) > “JEHIHMRK” (Control Panel) > “ X%
FIEF LT (Region and Language Options).

“IX I AITE S %557 (Region and Language Options) A& HEFT TT.
2. 47T “XIR3EIN” (Regional Options) XTI+, Ff4Txf Bk RG AT RS
3. fTJF “iE5” (Languages) &1, Jf4txf ARG TR E .
4. F1FF “m” (Advanced) EIR, JFEXT HARFIHAT R E .
5. T3 PC.
N £ RG A

1. SRS “TFIR” (Start) > “WE” (Settings) > “#EHIMMR” (Control Panel) > “¥#sin
MR (Add or Remove Programs)

BT O meiHBRREY” (Add or Remove Programs) Xi i

2. iy “Us kR Windows 41447 (Add/Remove Windows Components) %4 .
FHTIF “Windows 41415 ” (Window Components Wizard).

3. MR “4E ‘Windows 4Lff 1) & ARIESEIEIT” R AU, FEFIZE Hk s ALE X N
S IEHE .

4. il “F—” (Next).

5. Hili “5ER” (Finish).
T ULAETER T 2%

PC Al 54%
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£ “Windows AT ” HEEHLEI

(AN N

Bt AN S AR P 1. M “TEAIPERL” (Details).

2. %% Windows XP &R “Uixk” (Games) S ikHE.
3. Bl “HiE” (OK).

IS — Internet {5 ERS: | 1. UK LA N I08E %055«

- OS Web k%545

- PORIER RS g
- 17k BATCH J9#%411 PC

2. P N HFEFARSS R (Application server) SIEHE.
3. R “TE4IBTEL” (Details).
4. wTPra e e, BRGNS
WS AT i 2% 1. BuEIZRS .
EFEZER
o “Hn{A >k Windows XP Professional 22531 S A AR SS | (TLRE 68) 7 #B4y
o “lnf>h Windows Server 2003 ‘%2574 B AFI IR 55| Culhd 89) 7 #i4
PC A5
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4.3.4 W A BRAE R 2R S5

f&j /v

NSRRI 2RSS, W LG 22 e 45 A
R A

YA

5% pcs7readme XAF, VLT BT ARA o
Bk

o BERZ W,

o PC SifEAMIEITEEE TAEA P IEIT (B RE SRS .
puy

1. 7t CD Wzl rhidi A %% CD.

2. MM “<iE RG5>.exe” SCIF)A B 2R B

3. ikt “FRBZVFAIMY” (1 agree with the license agreement) 5 HE I Bl « 2o ”

(Install).

4. INTEREEE IR, ERA s FHLREU %3 CD.

B nAE 8

U B BAME R MEAMER . RS (DR 138) 7 Ry

PC 214 54%#
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4.3 ZHRIERS

4.35 AT 5> T A fi 2o

fai g

XTSRS, B AE R G E0E 2 A A 1) CRIUAAE: ERAE RS X RERAAIE) .

BB TOCAF RN
I BRI R NIRRT PC AR A A o BATHEBGEEAT AN BEE

2K

M w0 DN

o

PC 4l 51

7 O K/NMEE S PC H A RAM 1) 1.5 2 2 i /ifi .
h 53 GESCA BT 4a RN e KAR S A AT R PR

PC ulifEAHIE AT 8 AL TAEA s fT (EAPRE ST

. £ Windows ¢ J B g5 rh s HE “ TGN

PSR4 “3CfE” (File) > “J@M” (Properties).
FIF “m4” (Advanced) T .

7t “PERe” (Performance) 4, il “PEfgikni” (Performance Options).
BT “PEREIEIN” (Performance Options) X 1A .

FIF “H4” (Advanced) T .

e “HEPINLE” (Virtual Memory) 41, ¥ “Fig” (Change).
FEFHIETI “ 152 LK/ (User defined size) i\ BT (I »
Huiki “Hfie” (OK) fRAFREE .

FRET IR “H5E " (OK) SR AL R A AT IF IR0 T AE o
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4.3.6 W HEITIR IR K R E

R

PC SifEAM B A AE TARA HIEAT (EHMRIMA S D .

1. EEEER A “TFER” (Start) > “BE” (Settings) > “#4lfARK 7 (Control Panel) > “&# T.
H7” (Administrative Tools) > “i1- 8L ” (Computer Management) > “ZsHiFH - f1ZH”
(Local Users and Groups) PL3EE /7.

ARIEFEHE LR, a3 WS HT 4R  C5hg 89) 7 4.

2. PR “FFER” (Start) > “HE” (Settings) > “IEHIMHAR” (Control Panel) > “ 7"
(Display)-

KA TP LB WoR i PR X R HE .

FIF “%HE” (Settings) LI, HHFHEH=4 iR

(X JPCS7, #illik+E: 1280 x 1024) .

B R I o e ] B AF R PCS 7 BRI R ThEE, At e Hh (e TR A T 7 2
VEo TERIOR O3S TAHMN IR SR T, I HATH a1 A

HIF “BRERY R (Screen Saver) £+ .

1E “BEHRARFEIT” (Screen saver) X3, M FHFIRMEFEPE “[E]” ([None)).

76 “URPMLE YR (Monitor power) X1, Hidi “HYd...” (Power...) #%4..

e “ONF o 5B E YR 7 % (Settings for Home/Office Desk power scheme)
DI, AR Ry EHEh kS “ AA” (Never).

ol “HaE” (OK) S RHEHE

3. 3 Windows Jli 45 #5126 55 W9 4% I FH R e 10 5 dis e 7

66

Windows Server 2003: iE#EH a4 “FFaR” (Start) > “WE” (Settings) > “ MR iERE”
(Network Connections).

TR PR L8 bty S\ 2R 1) X 48 T4 42

A Ry 4 A IE R, B, oSkl L) M.
R A “3CE” (File) > “IRA&” (Status).

P “HI (General) I .

i “JEYE” (Properties).

EFE “Microsoft W2 11 S AT EIFLILZE” (Maximize data throughput for network
applications).

i “J8 1" (Properties).

MR I KAk 2% I R 7 i B ik &7 (Maximize data throughput for network
applications).

s “HRE” (OK) IKHITEHE .

PC Al 54%
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4. AT 4 3T P4 1)1 BB I IO
AR E B 2GR, nIS2% “lnfarst H N2 G BLAs (10T REZEI (Dohth 99) 7 47

5. WLPEEMA “FFER” (Start) > “&E” (Settings) > “#EH|MR” (Control Panel) > “#&¥ T
A” (Administrative Tools) > “I+EH & ” (Computer Management) > “ZR4 T.E” (System
Tools) > “FHA-EF " (Event Viewer), #2514 IR S AR SRR J& 15 #E 1E 3 TAE .

6. OS rses: 76 “fihlM” (Control Panel) #, %&£ “J5 &%~ (Background services)
LA

PC 4l 51

PSS “TFER” (Start) > “H&E” (Settings) > “#&#IMHMR” (Control Panel) > “ &
41” (System).

BT “RG @1 (System Properties) ffiGHE

HPE “Eg” (Advanced) £,

& “PERE” (Performance) X, i “&E” (Settings) #%4l.
e “mg” (Advanced) LT .

% T Windows Server 2003: £ “4b#i#%it41” (Processor scheduling) X+, %
£ “JEE RS (Background services) ik a4 .

Bl “HiE” (OK) SCHXTHAHE .
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4.3.7 4T > Windows XP Professional 2235 7H B B\ Ik 5%

2 PCS 7 AT, SE7E PC uli bzede “WRBAFIRS” -

EBN
o WIii%E Windows XP Professional #:1E &48, LAKMRS AL Internet Explorer.
o PC uifE A EE 7 TAEA PizdT (HMAR AR ) .
o LU HE 51 B 4y % 5% 2 Windows XP Professional.

L

1. LML “TFER” (Start) > “HE” (Settings) > “##IMHMR” (Control Panel) > “#il
BMRFERF” (Add or Remove Programs).

2. il “UsinmiiEE Windows 4144”7 (Add/Remove Windows Components) $441]

3. kFE “WERAA” (Message Queuing) 414
FHEE “TEAME R (Details) 4

4. i “VE4E R (Details).
BATIT “W EBAA1” (Message Queuing) X G HE

5. ¥EHE “HH” (General) 41k,
SPATI S FALE, RIFHRT “HiE” (OK).

6. i “F—2” (Next).

7. WIRAELHATIZIRME RGN PC _EAPE T W EBAIIIRSS " M, W2 TR R 30
IR W EBIUIRSS” ARA T, 3TIT “ i/ i (Data Medium) X A :

- KPR H) Windows 3¢ CD 4fi A CD Kz)#s .
- i “HiE” (OK).
¥ “MS BB .
8. M “5gik” (Finish) Jii% A 5.
9. ffH] “HMEFN” RMALEEMES T “MHERIIRS”

— EPESEHGA “TTER” (Start) > “¥E” (Settings) > “##IHEHR” (Control Panel) > “%&
HTH” (Administrative Tools) > “Z{f&&28” (Event Viewer).

- EREREH, ERE CHUEERS” (Event Viewer) > “NHIFEF” (Application).
W “Yi” (Source) FIHALELAH “MSMQ” , MR EMLE: T “WEBASIRS” .

ANIERHHI TN BE

WIRAE “FHFETE” (Event Properties) SHEHEN “Hiiid” (Description) N HHEL T — 445120 &,
W) W M 22 VAT TR T NS e« AR 2% &

PC 214 54%#
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4.3.8 A % Windows Server 2003 223531 H A B RS

fai g

2K

P&

ANEMRIZhBE

PC 4l 51

23 PCS 7 i, SufE PCuli bzedke “WiRBAFIIRS” -

DA AE Windows Server 2003 #:4E &4, LLAARSSELA Internet Explorer.
PC S {EAMISATEH L TAEA FIET (AR,
F P DL B 63 5 ) % % 31 Windows Server 2003,

. EPESEHAT A “TFER” (Start) > “KE” (Settings) > “IF#IMHIRK” (Control Panel) > “#in

HMIBRFEF” (Add or Remove Programs).

s “CEs /R Windows 41447 (Add/Remove Windows Components) 2411 .
R N HFEFIRSS 2 (Application Server) 17 CREEEFFHE) , ARG “PEgifs B

(Details) %4l
WHTTF “ NP IRSS 457 (Application Server) X 1 fE

. ERE “WEBAFN” (Message Queuing) 1T CAEEEHHE) , RJE M “TE4I{EE” (Details)

i
BT “W R (Message Queuing) X e .

gk “IEA R (Shared Components) HE. HUHE A HUEHE, X558 “Aie” (OK).
- WERAE A S E RGN PC _EAEE THT “WEBIIIRS” BIEAE, W RIE B,

WARAT “WHEAFIRS” ERAEART, 4T “ddlinit” (Data Medium) X 5HE:
- R Windows ‘%% CD ffi A CD BKahsH

- i “HiE” (OK).

Kk “MS T ERASI” .

.l “5E” (Finish) JHIE 1 S
M AR REREEMT T MRS

- EPFEHa A “TFER” (Start) > “BE” (Sefttings) > “#E#HIHEK” (Control Panel) > “4&
¥ T H” (Administrative Tools) > “Z{4&E#%” (Event Viewer).

- TEREREAS, % “HHEEESS” (Event Viewer)> “NHFERF” (Application).
W “JE” (Source) FIHEE4H “MSMQ” , WKW C&IEMwE T “WHRMIIRS” .

WA “ifJE M (Event Properties) XUEHER) “Hifiid” (Description) FHIL T —4451RH B,
W B 2 AT IE AP AT « N2 B e “VH EBAAIIRG:”
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439 e 222 i hn A4

LN R PC 41252225 N Microsoft 411, X4l {71 PCS 7 Toolset DVD L[
“Microsoft” S fE3erh, #i#% “MS_ServicePacks_u_Tools” DVD k.

Vi g
WHR A PC 4122235 i Microsoft 4014, NI #E pes7-readme SCAEH HE B BCHT A OAE B .

HE
T R PR R GETR F ARAT I BN Microsoft 4%
WA E T 55T 0 H s P AF A B AN 1 5451«
BE HERG “MS_ServicePacks_u_Tools” DVD L H%
Tl german Tools\MS_XPSP2_KB319740\german\WindowsXP-KB319740-v5-x86-DEU.exe
i english Tools\MS_XPSP2_KB319740\english\WindowsXP-KB319740-v5-x86-ENU.exe
EE french Tools\MS_XPSP2_KB319740\french\WindowsXP-KB319740-v5-x86-FRA.exe
RO italian Tools\MS_XPSP2_KB319740\italian\WindowsXP-KB319740-v5-x86-ITA.exe
VLA spanish Tools\MS_XPSP2_KB319740\spanish\WindowsXP-KB319740-v5-x86-ESN.exe
LT AR AR A 1) ST A A AR 2R AT 5 T S
BE HEA pel
fi xxx_de.xxx dotnetfx_de.exe
W XXX_€N.XXX dotnetfx_en.exe
1 XXX_fr.xxx dotnetfx_fr.exe
BB

1. % DVD ##i A DVD Kzl
2. %EF DVD A A2 .
3. %% pes7-readme U IR E I ALEE

PC 214 54%#
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4.3.10

faifr

ZERMEE

2K

SR

PC 4l 51

4.3 ZHRIERS

Hn4a]22%% Microsoft SQL Server

1E PCS 7 %, I HLLT PC w223 Microsoft SQL Server:
o PRAE Uk
o TR,

B4 “PCS 7 THA” WA —El®—ik CD, HA % Microsoft SQL Server % ff (G&
HFT PCS7) .

L]
PCS 7 Jii ) Microsoft SQL Server ¥ LR PCS 7 %€ 1) SQL Server e/ ¥, o
i BB E . ) PCS 7 #R4E bhuli 22611 SQL S5 “WinCC” .

BE RGO e,
PCS 7 ¥55E % SQL Server 2% CD #[ . M PCS 7 V7.0 7144, ¥ 75% SQL Server 2005.

PCS 7 Toolset DVD [¥] pcs7-readme SCAF AL T RAME BBA KA G “MS SQL Server”
(RIBEE N HAE AR BB AR 7 (45 R

. 1 DVD ¥#h#% 4 A MS SQL Server %3 CD.

WERPIGE X RHER A L, EE Windows ZIRE FLASH 4 4 CD ahay, Rinisfr i
“setup.exe” Xff.
FHFTIE “Xkad...” (Welcome ...) S 1fAHE .

. Bl “F—207 (Next).

BHTIF “UFniE” (License) RfHEAHE

CIERE “IRBEZ ULV ATIEMMYLI 4T (I accept the condition of this license agreement) ik

4L

il R 287 (Next).

BT “FRPH...” (Program packages ...) X iHHE .

. MFIF ik “SQL Server 2005 (WIinCC)” .
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6. ik “F—2” (Next).

KGHIF “FEFP...” (Programs ...) XGHE,
7. ¥y “F—7 (Next).

ZHRERI A B .

BATIF “WRIn sa B3k 14” (Add password for the sa login) 4 iEHE
8. i “4k4:” (Continue),

B TF TR HISCE...” (Start Copying Files ...) $HiEHE.

9. il “3k” (Install).
BN 4x22% SQL Server (13014
BATIF “z23k52 k... ” (Setup Complete ...) XFiFHE.
10,5k “52%” (Finish).
BATIT “223 SQL Server 2005 (WIinCC) ...” (Setup SQL Server 2005 (WIinCC) ...) X 1iFHE .

M2 )n, fEJa sy “5g” (Finish).

“SQLServer2005MSSQLUser$<t+EHL44>SWINCC” H )4

72

1 PC b4&T SQL Server %A, RISTEEAE RS A1 “SQLServer2005MSSQLUser$<if
HHLL>$WINCC” 4.

“UHEERLA T i PC iRk CRidrd “FFaR” (Start) > “HE” (Settings) > “#H R ”
(Control Panel) > “%&%” (System) > “iI 5 L4 F5” (Computer Name) LI ) .

P40 4 Frset]: SQLServer2005MSSQLUser$0OSServer1$WINCC

W
JE 58 A BT 2228 i, LU AN BT (R

ARETEELZER, W% “BCg M4/ s 89 7 .

PC Al 54%
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223 SQL Server #EHMEF

1.
2.

7t DVD ¥ zh#sh4E A PCS 7 Toolset DVD.

1. Windows WS B, 7R 45K N k£ DVD BK ) d FSC1k
Additional_Products/HF_fuer_SQL2005,

EHECAE “sqinclimsi” o FEPREERFLH, SR RS 38 (Install).

FFTFF “Microsoft SQL Server Native Client ‘%427~ (Microsoft SQL Server Native Client
Setup) XJ iEHE

. i “F 257 (Next).

FHTIF “UFriE” (License) RFHGAE

CIERE “IRPEZ IV ATIEMMLI 4% (I accept the condition of this license agreement) ik

eI
i “F—27 (Next).
BATIT “HEHE B (Registration Information) X 4 AE .

i R (Next).

BATIT “HEFF1E” (Feature Selection) X5 AHE

iy “F—27 (Next).
BHTIT “Hi g 225 ” (Ready to Install the Program) % ifHE .

. B 22 (Install).

M2 2 B AN o

10. 505 “52/%” (Finish).

EZER

W2 “MS SQL Server” 4¢3% CD I SQL-readme.wri XXAF .

PC 4l 51
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4311 WA RIEMRERASREHAE

R

W R EEAE OS R4S % L A# ] StoragePlus #/4-1, W#h7ri% OS s as AT UL R DI,
Fk

o [\ 'z% Windows Server 2003 #:E &4t
pu =

-+ Windows Server 2003, FHELE IS, ASP.net:

1. 18 “THR” SR, W “RE” > “RESMERNSF” .
RFTIT “ MR ss B e 27 .

il « T

LEBE 5 H L I N T A TAE T 1S

il « T

ER—uih, b “MRESAME” A H “NHRTMSS (IS, ASP.NET) 7 .
iy N7

ER—01, Ak “JaH ASP.NET” 551 I S IEHE .

A

TN RTIZE: S (e

© © N o o k~ 0N
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4312 %23 SIMATIC BATCH M niR%

feifr
R EAEH] FTP 4£3% SIMATIC BATCH JA#Y, 67284 PC W LU T e,
B R AR 55 ?
PC 34 FE B RS B
BATCH JAR44&1% 1) H A% PC ki 1S k45
FTP %5
FASK¥eE BATCH HRSR% 1) PC b FTP 45
FHS 7 il 4%3% 1K) BATCH JR% 1) PC 3 BATCH #il 1> (BatchCC)
fi s B
o HRAXRMFSMEZEL, WSHFM QIS RS PCS 7; SIMATIC BATCH)
(Process Control System PCS 7; SIMATIC BATCH),
PC 412 542kl
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43.13

faifr

76

W] e BB T SRA AR R

CRILERPIT, AT Q3 ST M T AOR/NRBCE . A BN IR XS R

1. EFER A “TFER” > “RE” > “EHmER” > “BaR”

BATIT “ BoRm ik XRAE .
Bl &
1. GLFE AP IR,
2. FATRA R B

— 7 “EIRERH FRAURR, EE “Windows £t .

- fE “Bi R FHsEky, &R “Windows £t
_ ﬁ‘f“a:l_“ “’ﬁ};ﬁ » o

- il AR
FHTIT “ g obuL” JAGHe.

—fE HHT FROURHES, A BORRE
BT SRR B R €.
I 27 SRS B T €.
- HE
FHKA
1 AE SR T RAIE, W R
7

1. i AR
TR “ R RHFAE.

2. ZH “Hushi Bontd AR BIEHRE.
3. $$ “ﬁﬁﬁ’:” R

PC 412 5%
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4.3 LRI ZS

4314 RIEEH

2
HOF A SIFM 25, A0 R AT IR RGPCS 7 AT 731X

N AR o DXABE AL SR Bl 5% K, Sl A 2 e R A o AP A5 v I 2K A2 DX B A A5 9
BN, BT PC e I F8 A

L]

TR, VRANIE S PINERGEAS RERE A — i 4 6 o

o FERUEBMETT, FEBVFINEF s RITEN L BRI . 72X A
o EFEMMBEATI, BORZPAEE G T IIRE R S

o CLOVEBRE, TEIBARMERPT IS KB

PC 4l 5
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4.4 2% PCS 7 #1F

4.4 23 PCS 7 %4

441 274 PCS 7 W HEREIN

B EHIRRA

BHTH ZARAE R

78

PCS 7 $k R e A7 TRIRYF, ALK IR0 DAL RETFAEIE T IR R S A
Wil WRHAHCAIBEITIRRIT S, ATV T PR ARG 5 TG LR T T RS
LR 522

BT EITAENXS PCS 7 RATHIR A SR HAT I8, nT %5010 STPCS 7H 5% HIKTEAN
A, SHASFM (EREHIRSE PCS7; THRS) (Process Control System PCS 7;
Engineering System).

THAHEEAR PCS 7 #8123

k517 PCS 7 Toolset DVD AHIG [ # AL LA IS B, nI2% PCS 7 Toolset DVD |
() pcs7-readme XA}

wH
{EMEE 24 PCS 7 1, itk 2 /047 —A> DVD K5l a5 LS — Mgt 35 sl s nl A8 1

ViEH
[ PCS 7 Toolset DVD | pcs7-readme U4 A HRAE 4T 5% 2020 K 3 2 Sk 1 B A L

B
RAERA R %5 PCS 7, R0 A A LIS 2 A s e B, Ttk S L S
BRI AR AN B AT .

wH
U R ARAE ] Windows [k dik, W25 22 5¢ PCS 7 Jia A REIE & -

PC Al 54%
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LR PC I

A

4.4 24 PCS 7 #1F

1 PCS 7 PC 1SR Ze AP MR BFAI R F7 fh. AKUNAS ) Tl BBEsti PC 35 (OS,
BATCH. Efediih)) JLisfI.

ST FINTHIE AL Siemens IR FTFEFF 24 PCS 7 RAHERE 4 AR
PS5 e AR AT T

WS B 7 i WRHE S PCS 7 2 500 . PCS 7 RIS =7 i
eI E T

E—A PC ¥ L2724 PCS 7 MARERF

LR IR S A

PC A5

—A PC B I T84T A PCS 7 IR (il OS kdss) o il 124724 PCS 7
I HIFERE (Bl OS Iks54sA BATCH %70l o EZARMGE, W% “CIMERAE (0
i 193) 7 sy

L]
FE22 e AR e 55 #5 1 StoragePlus I, 8 s 1 BRI P BB ) —FiiE 5 .
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4.4 2% PCS 7 #1F

SIMATIC 454

80

LR M. DCOM LUK Windows [y KB4 bt AT —2eie s,  DAPRIE PCS 7 AFH
TeMRiaAT . ZReeaa, WL “SIMATIC 24x45H]” (SIMATIC Security Control) X iFHE, 1]
LR P TIR SRR . A LT UM A] ik

o A RN N XL BRE, W “NV T (Apply).

o RANAE DUR U TIZ e E, WIEPESR A4 “FFAR” (Start) > SIMATIC > “SIMATIC %
£¥:#]” (SIMATIC Security Control) > “Fra % & ” (All Settings).

o ML M4 “FFIG” (Start) > SIMATIC > “SIMATIC 224:4%]” (SIMATIC Security
Control) > “ERATHIEE” (Settings Made) iz “SIMATIC 4 H]” , ¥ B/RCAE%E
FIHAE RGNIBLE R

BB
WERTARR SR A (8 TARAD , MR ZUERSE R @4 “TF48” (Start) > SIMATIC >

“SIMATIC Z4#%]” (SIMATIC Security Control) > “Fr#%E” (All Settings) 7/ JTiX
LB

Windows [Jj k85 40F1 & b (58 G TASHBIN S, (I X3, Wil PC uhifr T ANIH]
g CF R A, D B e X 3

Windows [J7 <k 35 #1451 41 31 36 58 2625 1] Windows By k5% iR is ol T % B 1 .

HEZMKAER, W% “Uf kG PCS 7 v d | (1ifY 139) 7 #i4)
IR TAEMSE R AR AL (. TARLD) , 2R X e 22 4 W R

YA

s

o TP ELRZM) CRA, XECRE EEFME. DCOM Fl Windows 7 ki (15 4h a1
HEATHY .

o TEMHZREL RS V7.0 () CIRES, AERAH: Windows [ k.

o BEHIBI KBS FATH &

MR EEE PCS 7 RGN, 3R ) 22 BB L — 2 S5 AR K5 F 51 st ix e %
BT

PC Al 54%
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ZF PC 5}

4.4 24 PCS 7 #1F

442 TR 7E P 25 o 33 AT 22 3

%
i R L2 LA PC, B HEAT LU A TAE:

¥ “PCS 7 THAH” DVD LN ASHIZI I PC #Erl s ln) FORERE o XhE, sliny L—acdk
JUA~ PC.

oy
W 2% 222 PCS 7 15, 353 5% LR 0]
o ffififs PC ¥ N: PC EHE8N)GE A3MKE L PCS 7 A /L H S k.
o X'E PCS7 B Hk CUFkeigkahas) MLz gk,
o L LUR U RIARR :
- HAEH
- R%: R

R
1. Kt DVD (¥ 302 Sk
IRIG AR EEAE 2% PCS 7 ) PC _L#§AE.

2. 17T Windows #YRE HLSE, B4 DVD A 2 FTAE 1) SO

3. BB R .
FHRIEEBELZER, a&% “lif] el PCS 7 HA4E (iihd 82) 7 47,

PC & 544
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& H PC 7f

4.4 2% PCS 7 #1F

443 fnf] 223 PCS 7 it

B/
PCS 7 Toolset DVD i PCS 7 N R I 52 384k 4. R4 P HIr PCS 7 R, W
B4z PCS 7 Toolset DVD H [ 52  HFL T o 7EIEIY B, PCS 7 RS fe b il
VFAJHE
A[{EZ4E PCS 7 2RI Ja ARk S AL BT 75 IO VF e 25 8 o
BV RS, nTS% “Urnl FfEA PCS 7 %AE (75 108) 7 #4y.
B ZIER
PCS 7 R4 FE 43 B 2 2 PCS 7 BT A 40 15 O e Hr PC F.
W E R, Sl 4T B R . R S EMATE G &1k, e B b R
R4 . SRIGE BT A8 PCS 7 RG34 R 7
K
o CVEIEHUERS, IFCOTER “CRIERERS” WA TR T DK,
o P IAN AR B 2B 3 PC 1,
o HHIHAY PC ub A HE B o
Jazh PCS 7 8%

1. 1t DVD ¥zhsh3H A PCS 7 Toolset DVD.

2. XWili “Setup.exe” BN
PRI E .

PC 214 54%#
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Z2F PC 5ff

4.4 24 PCS 7 #1F

BEBEFHHIRE
PUR AT KA 22 e FE P A R AE th T b AT R BB BOAE B s XL B2 U AR PR AR U7 41 1 -
BFELFiE 5 (Setup language)
— i, #%F “TEE” (English), RJEHd “ N7 (Next)
2. ¥l (Welcome)
- R 87 (Next)

3. 5 B (Product information)
. BN EAZAE R, RJEHRS T8 (Next)

4. HFAUERMY (License agreement)
— L TEAERE “ FRIZESZ VAT B A5 A DA A TRV AT B A A

(I accept the conditions of the licensing agreement as well as the conditions of the
Open Source Licensing Agreement)

- . “ 27 (Next)
5. &N (Setup type)

— . ANERERE 237 (Install) B “HHT” (Update) SRik# iR, RiEmid “F—
27 (Next)

6. M/ & (User information)
- WARPER, REHd T2 (Next)
7. 3O (Installation type)
- WRTHEE S PCS 7 MR FF RIS, MIkrh b AE “ e Lede”

(User-defined Installation).
- WRTRE S A BRSO, W “w” (Browse)
- i R4 (Next)
8. M (W TED
- LCEFEREPA, RERE R 207 (Next)

- fERE)S HILRXHEREF LR PCS 7 N IREFA AR JEPARNROHE CrIE “IETAIERI 2
A (BT 193) 7 MBI EARVUER ™ L) .

S0 AR T & R A TR Ik PCS 7 N TR 2 ke AT L
9. ¥ (Programs)
- BRI, WTRLEAN I PCS 7 MBI CERATD s
- ol “F =27 (Next)

PC & 544
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24 PC ik
4.4 2% PCS 7 #1F

10445 205 T ik i H 4L (Ready to install the selection)
— g (Install)
11.SIMATIC ‘4= 457l

“SIMATIC Z24¥#1” (SIMATIC Security Control) X[iEHEM) i #4> Bor T PCS 7 &%
LR ] 3BT IR E

B “SIMATIC Z24:14H]” (SIMATIC Security Control) XJiFHE N i & 70 if5 &, Ifik
PR [ F2 0

HRETEBE 2GR, 1I3% ATk 3T PCS 7 Mz E (T 139) 7 45,
12, 8858 G, R LRERE T
13. 5 H1)H3) PC.

— Description
[ JEngineering :I FCS 7 Engineenng includes:

FCS 7 Engineenng STEP 7. 57-5CL. EF!:» SFLC.
[JBATCH Engineering Lo R il
. PID-Tuner, :
[] Route Corntral Enginesring WinCC, Remote Publisher, SFC
] PO Wiz, A5-05-Engin., PV,
(]Runtime FACEFPLATES, SIMATIC MET,
C7Single Station Syztem Document,
[J 05 Single Station
[J BATCH Single Station
[ Route Contral Single Station

[5erver
(105 Server ;I

< Back | Mest = I Cancel

PC 214 54%#
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Z2F PC 5ff

4.4 24 PCS 7 #1F
PC WifE A RS 75, AT HEMES AP TEMTE
TiEA
W PC uifHVEZ T/ TR SO RS 28, 4 25i4F Windows Server 2003 4 & 45 22 T
Rk o

PRSI 55 s AN 2 PCS 7 VFATIE
T RAEM 28 IR 55 o LACREIH 2N, nf 2% STEP 7 774).

T B 2 A 5 2 i P 44

WRAE PC B2 T A MERIENCAS, W Z0ise B 2 280 i Lk I M 4% 38 4%, LMERES /1 PCS 7
T) k% PC.
ARETENELHEE, TS5 QT B m g #).

RO RBER A
AR PC g TR .

WP 4 “TFUR” (Start) > SIMATIC > PCS7 > “ &3 #4:” (Installed Software).
“7in” (Products) dE 0 o4 ks O 22 1 AT .

HES L
o [l fa] ZH 2 AL ER (ThE 131D
PC 414 5474
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2R PC ik
4.4 2% PCS 7 #1F

4.4.4 WAl 22 e S 9% AR 4528 (StoragePlus)

s
{67 “PCS 7 THH"” DVD %k RIS 3% (StoragePlus M52 1Y, Vi 2eFUFH A
TFBL PR

E2EN

o AT SQL RN HIETF RS % (IS 1 ASP.net)
o ANk L) AV ENLAFR .

7t “StoragePlus ZIRRE” MIGEFHTRE.
1. “Ues BTk b4 (Ready to install the selection) S FEFRfEHE S, By «20s”
(Install) 424l .

¥ HTIT “StoragePlus ¥ E” HHHHE.

i HA
“StoragePlus L3R E” XUFHE B E — HAfie, AREH L.

2. BATUA R B

fE NE

Hdpe )72 4 By - i NI PR BB AL R

e e 4 BB PCS 7 I iy A IR S5 s A RE A8 B e SO il e A

o H G AR i N EE S 842

FE IR H % B ANSEEARS H R BRI A4 TR
SCEARI I DR OS IR S5 & B VRS BRI 35 et 21 b e JF R R 55 s O 46
R (RBRAE) .

HEMKRER, W% “Uifid PCS 7 8AF” Ho).

PC 214 54%#
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LR PC I

4.4 24 PCS 7 #1F
BERERE
=8
o Bl FE AT AR B AN B EEA IR, R ETR
- AABEEE - BdEE 4 “DBName.mdf”
- HAEEIE - B E &S 4: “DBName.Idf”
- IBATRGHRIE - B SCE 44 “DBName_D.mdf”
- BT RGEIRE - e 0S4 “DBName_D.Idf”
o R, A HIINAT HOEH B, 3 A AU P A2 1A PR 44 PR B R L ) P A R A
WAERA LU KT AL 50 DX AT ARG s, 0wy ASRAS e £ R RE RN B A e 4 1Pk
o AELRE P MR B SR H SRR A BCE B Windows BE RGN X .
o ANEAELL R X PR e B (B, BRAE RS A A3 -
- HEHEH R X
- FEERAE X (R T BBhARERE “hiR AR E 7 (Fraction of hard disk
capacity) £
AT RE IR, A8 AR A B 5 F IS ) B S R T 20 X R e ax (g 22 ) o X RE T
TRREINI V) 22 DA B s A
o fPRILEEIARY H M0 X EA RS I A R R 0] s X, BRI b SR IR 45 g R
& ibJn, OS RSBk S AR B
SRR AL B A I A ] g e VA AR R 2% ae M e, FRATHR L DL il
o {1l Z AR I AR IR 55 25 -
o NELWEIE I M AR W E B e T PC SR E RGNS CRREMEIAELE) .
et e 2t
IR
o A RAID A4t (RAID 0) ki mitkfe.
o AU RAID 5%t (RAID 1) Sd i AR R 55 25 i 4 e 4 1k
HES N

o {2 PCS 7 At (Uihy 82)

PC & 544
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ZHE PC 4f

4.4 2% PCS 7 #1F

445 ABRTURBEBHBHITNER

fEj A
T h PCS 7 LA MRS 28 LA TUA ML o
o Ty OS 4578 BATCH R4 2841 A B A MM 4G meas T IUATE D AL
KMo
e SIMATIC Bz ¥ il FH 2y 2 2k BEAT TU Al o
URgIE Sy

HRNITCR MR BRASEAAL TURAICRIEMNGE R, WZETN GG R S PCS 7;
PRI RS (Process Control System PCS 7 Fault-tolerant Process Control Systems).

4.4.6 223 T PCS 7 OS Web &1 K] PC

PCS 7 OS Web 45881 PCS 7 Web & F WL\ %4

4% PCS 7 OS Web JIRZ528F1 PCS 7 Web 2 S HLIK BT AT 15 B ANTE4N (K0 Rt i, AT %
ZTH GEFEPEdI R4 PCS 7; PCS 7 OS Web #£3i) (Process Control System PCS 7;
PCS 7 OS Web Opfion).

iy A= B
o CERPFRAIIFHVIIIEE T (VR 158) 7 5

PC 214 54%#
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L H PC I

447

wE AR

4.4 24 PCS 7 #1F

2% PCS 7 B AFit 2 B Gl — L8 Al 4L ) .
RIS T RSN He A R S s ke A T 4

GEE AR R T R R
£2 3 N QIVSE O | e 1 S | YR N 0 A DA MDA E R I R bV
o e — g ORI AN i A ZiAE PC s b AT
o CHfE” —FIE X PCS 7 ey I I A P HIRR LT

o “HAMIHMH” —HH AN Ash QIR AR . HPARL R

brid.

o UG —HIFIH TAE PCS 7 ARG gy KA AL

e ‘2%z SQL Server W< AN “SQLServer2005MSSQLUser$<ilHAL4>$WINCC” H F

Ao WAZ0HE “HMI” F AL P A I 2 e 414 e PCS 7.

R AP
2o A ABHPRHAPA 547
BIERS B ¥ PCS 7 PC (AT Fl P as Bt P4l
PCS 7 i SQL SQL Server A 4 (B ¥ CHMP” H P AR RS s n 2 e 4l
Server “SQLServer2005...” #FH
EHEIO
W ik PCS7 T/ HMI OS Wi H L2
T H & R
AR
FAER YU
BATCH T ¢ SIMATIC BATCH BATCH it H T
PRAR R TR RC_ENGINEER PR ARFR I LR
RS_MAINTENANCE E%ﬁﬁ%ﬂﬁl;iﬂ (@S yIEe WE)
B CHRERE AR, &S ILTF-M
RC_OPERATOR_L1 Gl R A% PCS 75 SIMATIC Bs42#71) )
RC_OPERATOR_L2
RC_OPERATOR_L2
BITRGIRS % | OS IR5s4s HMI 5 H S 5
B1E R
BAERY
BATCH R4 %% SIMATIC BATCH BAE 0
PC 4175 54240
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ZHE PC 4f

4.4 5 PCS 7 #1F
24 A EFREPMAA LR
AR IR 25 A RS_MAINTENANCE AR
RC_OPERATOR_L1
RC_OPERATOR_L2
RC_OPERATOR_L2
BATRS: OS vk HMI TUH &0
ARG BRAE
EAE R
BATCH . T 1Fu5 | SIMATIC BATCH HAER
AR T AESE | RS_MAINTENANCE AR
RC_OPERATOR_L1
RC_OPERATOR_L2
RC_OPERATOR_L2
L 0S % 'L HMI T H B
AR R
PERA
BATCH %7 #l SIMATIC BATCH AR R
BRI L RS_MAINTENANCE AR R
RC_OPERATOR_L1
RC_OPERATOR_L2
RC_OPERATOR_L2
SIMATIC Logon LOGON_Administrator
P& BT
X 43 LAR PR O«

e Windows G SIMATIC Logon B¢ /2 & B

- B~ PC LR
- M Windows (ki) PC) AN i {7 B P AT - 45 B
o JE#|fFE SIMATIC Logon (] )= & 5

VF% PCS 7 MAIFEFF#iScFriliid PCS 7 (¥ SIMATIC Logon i T4 rh R A BE, XA
BHET Windows P45 FEIFEEASHL] . SIMATIC Logon #4517 LATR FH P4 A S D it -

— ° )\ Windows (3] PC) HIFEAN ufi B AT HE SIMATIC Logon HIY™ e H P & 81
- {EH— PC #7145 SIMATIC Logon (I3 Ji& ] Fr 4 B

PC 214 54%#
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LR PC I

4.4 24 PCS 7 #1F

#% & PCS 7 i) Windows Fi

AP R

1. Windows FHi, 2 HAAN %3¢ PCS 7 AP, AR I L I o

W R RALA ] ] PCS 7 4144, WIAZIAE Windows Wk BABAT], IR L0 BCLh AH R 1)
PCS 7 4t (FH4D) .

o DURBUIIIE A H R 2L A A A 1R T

5 AR Windows JIk45#4 Enl I AT 41, IF N Windows RIS T 7 B e X
Y.

o i}l SIMATIC Logon & S frtalis, LR REUGEH] :

Al{E—4% PCS 7 WL (B4 SIMATIC BATCH) 1A FH 7 I - 40 23 lic s 52 £ (1
s24]: SIMATIC BATCH

- HPfmEh g E PR (AR

- BEIFENEARVE M GRS RE TN

— BAL) T RV P A GBEXRMREANRRE D)

PCS 7 N HIREFA vl il Hh s 8 S IR 5 3045 CE sk N R L, DR e 5 0] B % b AT AR
fl S e DL e AR B AT

7E Windows 3% A ERAIE S B

B
DU DTAEIR T BT AL A PR AT RAT 5 R I A B 2 0 N S R A

PCS7 L] HHEE R

B nA= 8

PC 4l 51

L]

OV REAE AT AT R BOIRAE B 2% (i, BB T 8t PC ufidsinzse , JfF

HAELE PCS 7 Wi Hd TR,

FHF (SIMATIC: SIMATIC STEP 7) (SIMATIC; SIMATIC STEP 7)
&YW WinCC 158 74

Tt GLREEHI R4 PCS 7; SIMATIC BATCH)
(Process Control System PCS 7; SIMATIC BATCH)

Tt G FEfdI R4 PCS 7; SIMATIC B 4% 2H1)
(Process Control System PCS 7; SIMATIC Route Control)

F M (SIMATIC; SIMATIC Logon) (SIMATIC; SIMATIC Logon)
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2R PC
4.4 2% PCS 7 #1F

448 PC 3l i B kB

Windows [ ‘K 1%
PCS 7 i H##AE RGP k3% (0. pes7-readme) .

“SIMATIC “4=¥5#” (SIMATIC Security Control) 7£ “Windows [ k%™ (614051 % b k4T
WE R E

ARIET B PEAfE S, WI2% “ Tk S 3HaE PCS 7 iy« et i (i 139) 7 .

T B2 LB KRR K

it 2 CP 443-1 [R5 5E [ MR A REAE T Sk e AT B K%
HEZMKAE R, W% “HTIERNZ AL L] MERA (g 49) 7 #i5r.

EipIEESY
o CHITHERLR/T] MERMALE (5 49) 7 4y
o “llyifi 5% Open PCS 7 [1) Windows Bi K & (Ui 140) ” #4)

PC 214 54%#
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Z2F PC 5ff

449

ST

PC A5

4.4 24 PCS 7 #1F

EX e ]

W PC FOHAT PCS 7 HfFtL, W) PCS 7 FRYS 5 WAIRAE BT T e 25 S A
T AE R HE TP i 8 e B

o OB
o

ML HOR 2k, AT LU IR e e PC L,

I EORT, AT AR OB RRAS (KA DT B DRIEFEBTRRAS (K] doe B A2 o
L
HUBr PCS 7 BB /A 3 PC i

VtH
PCS 7 {3 L8t oo AE BRI A B B R 3 PC i

L]

IR PCS 7 WiH, LABGHTIRAH) PCS 7 B #AE I IRAS, 13 F AT S B B8 (1 -1
A L TR A

HEZMKEE, EHEFN GIREEHIRS PCS 7 BAFHRND
(Process Control System PCS 7; Software Updates)
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ZHE PC 4f

4.4 2% PCS 7 #1F

4410 HFEPCS7
WERELHH PCS 7 #, mIBL i IMARAHEAT 4%
Wt PC 3 EAFERE PCS 7, AT R P IRINER PCS 7 #ft.

L]
SORFALS PCS 7 1 H I ERIASCIEE

3

FEBUEHI LA~ 25 3%

1.

H#FE PCS7

94

N AT UEE ] o

2. & FTE VR T B AR .
3.
4. EHrwd PC,

N AT G

L R4 “TFHR” (Start) > “¥E” (Settings) > “JE4H|EH” (Control Panel).

BATIF “E= I (Control Panel) %1% HE

MBS, XGE “EmEERFEF” (Add or Remove Programs).
BHTIF “AInsmisRFEF” (Add or Remove Programs) X 54 .

i < R FERE” (Change or Remove Programs).
ML “SIMATICPCS7” .

Bk “BHBR” (Remove).
UL R PCS 7 %Ak,

PC Al 54%
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2HE PC 7
4.5 % PCS 7 2 I =) F)7

4.5 1 PCS 7 I WA TEfF

4.5.1 B R EE 2 O I Bh R 7

4511 B RACHE 2 RSN AE P

[P
PCS 7 R4t w35 Fe fp H 8l & Bl A 75 B XS RE P . U E 2¢3% PCS 7 2 B S 1 TH A
Yudi N PC 550 N A & anit.
WRAE 2% PCS 7 2 Jm B SOl A R (G 288, s b2 “PCS 7 T.H46” DVD
(SIMATIC NET PC A4 5 2 2% 1l iR AR B (Y 3R sh R .
R4 BN FH RE /1

1T PCS 7 i@ AL BE 25 SZRFRIAE EI ] . PC A BN 2 H 34T P i v

L]
DR ORA I 2 R R 4L0%, T54E BIOS HhA #2175 CLias B BT ZH PR RORL I . A5G e 320
EEZAEE, 2% BIOS it i 13k

X5 PCS 7 48 PC, R4 R 4L A1 BRI Ll BEAT A BRON IR S0

BREL (T PIRM) EREhY

MRFEE RGP R (Wi, MW TCP HH#:)y 1SO) , NIFETEAE T REMss %7 %
EIRAMY (TCP F1ISO) &

AR, KA AEI N E] AS LLERME S MR G .

EAT WA ANEEZE] TCP/IP 2 ISO M, PR AASEsATI G, XM d— AT !

PC & 544
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ZHE PC 4f

4.5 1 PCS 7 KR z)f2/7

4512 LRAA] Ay 3 VAR SR 22 3 IR Bh AR
=k
o R 22233 PC .
Jazh PCS 7 223187
1. 7 DVD IKz)% 35 A PCS 7 Toolset DVD.
2. Wit “Setup.exe” A LT,
ey i IPAY = by
ZERFPRRE

96

PUR A SRAER 2R 0 TRAHE T BT b AT BB A R IS U 4 LA B PR I 1)

1.

R FPE T (Setup language)

— P, R CUGE” (English), ARJEHLE R 27 (Next)
¥l (Welcome)

- R 27 (Next)

Hik 1 (Readme)

— E, BRSO, RE R “F 7 (Next)

. A ATIE MY (Software license agreement)

— IR AR (Laccept ...) BIEFHBGRIL I, RIS “ 27 (Next)
2R (Setup type)

- LETPERE g (Install) UE IR, AR)EHTE “TRN—07 (Next)

JH /15 5 (User information)

- EANRPARAL (AFND S, Rl “F—27 (Next)

L4 (Installation type)

— LIETPEEE P A E XS (User-defined Installation) 3 It 2R, SR <R

—” (Next)

. F&J¥ (Programs)

— . IETPEIEHE “SIMATIC NET PC #44+” (SIMATIC NET PC Software) #iGf2/ 7, Kb
iy “F—27 (Next)

PC Al 54%
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LR PC I

4.5 % PCS 7 2 I =) F)7

9. S BTkt (Ready to install the selection)

— LA (Install)
ﬁ%ﬁﬁﬁ%#@ T A oR 2 e e .

10. 23850 8 ), RIIRTTHAE o
11.E ¥ )53 PC.

L]
Un SR o S BB ST PR I TRAL PR, WSS AMAAT I IR B 2 A RAE
W22 U RCE bR PSS (oifd 97) 7 o).

4513 WA PRHEE TSR

BCE #11 Softnet CP & &

WRRGEAMM B (BIELM T B4 , @M T B&IES 1ISO WX, JFAEH
TCP/P thifl. fHA—AMlSMELL, W1 SIMATIC PCS 7 BOX. SIMATIC PCS 7 AS RTX LLJ
AL RE CEfE CPU R BAVF A LUK M2 1D AT IR o

BLEA
#£ HW Config F1/5% NetPro H 20 AW AL 24 T B 2Rk P

2K

C %% PCS 7.
BH
H PR B

W 4% E R 75 A & CP 1613,
CP 1613 fli lH e 2R A &R (ST %8 .

PC & 544
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ZHE PC 4f

4.5 1 PCS 7 KR z)f2/7

i

98

. PSS “TFIR” (Start) > “EE” (Settings) > “FI4%i%EH:” (Network Connections).
AR AR TCPAP PN M) L) SRl A2 (G , RGP asd “Br”

(Properties).

. 221 “Internet #}3L (TCP/IP)” (Internet protocol (TCP/IP)) SikHE, JEAE “HIERAEH T3k

SEMIZHAE” (Components checked are used by this connection) X5k H1##7% “SIMATIC TMkLL
KK (1ISO)” (SIMATIC Industrial Ethernet (ISO)), LL#H] ISO Bl i “HiE” (OK).

IR L —D0ERE, JRHE O TR BRSSO “SCHAIETEIHLIL S (File and Printer
Sharing). “Microsoft %% i 7 (Client for Microsoft Networks)) , K IL ZHg R\,

- T RAZAMIER A PC:

- EPFERGS “HEA” (Advanced) > “FEKE” (Advanced Settings).
— fF “HE” (Connections) X H 453 21| £ i 28 1) W0 28 3 4%
— T S BN P 12 ) 286 3 RS B B T

L “HfE” (OK) K HTAHEHE

. HEHTAZ) PC LU ISR E .

IR A “FFIR” (Start) > “RE” (Settings) > “M45i%EE:” (Network Connections).
BRI Rl THAR B ) LR R T

“Microsoft %% ;i (Client for Microsoft Networks) 5 1% £

“Microsoft 2% LA FIFTENHLILEE” (File and Printer Sharing for Microsoft Networks)
HEHE

. R “HE” (OK) KRN URHE .

A

NES% WinCC (7B A4 “lif 2 WS IE RO 1SS s (4 RIE TSR~ 32080 B YRt
FIi

PC Al 54%
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2k PC 1%

4514

fai S

R

PC 4l 51

4.5 % PCS 7 2 I =) F)7
G 2 P P 4% 38 B 28 FY) 75 FRL I T
VFZ AR I P 4835 e S8 7 FRRe YR A B Th e . Tl L IX e Th RS AT sk /b BEEE

AL, PC n] LU A B 10IG 2. nASHGE 7T REIEIT, U2 PC 7EBE NN BN
Kb FARBE PRI, XL ] PCS 7 PC sl il 5 0T o 2441«

XFFER R I 2N T PC, iU T Ik g

1. Windows Server 2003: #EFEHar4 “TFEE” (Start) > “¥E” (Settings) > “ML&ER"
(Network Connections).

PRI 1
BRI A S S > RE”
PR B BT

Haly “HE” .
FHTIT “Jm it <MZERCE>" X EHE.

6. MW RIKITHIET R, &F PC AN KL (2 TED .

o » 0D

EAETF, 2007 4F 9 Hhi, ASE01235050-02 99



LR PC B

4.5 2y PCS 7 % 4R )27

7. ZERITTRELDBE

Intel{R] PROA100 ¥ Metwork Connection Properties

I
I e e
r I =

100

PC 415
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2k PC 1%

4.5 % PCS 7 2 I =) F)7

4515 tnfauESs B CP 1613 M LAEIMx LAZE PCS 7 {8 H

faifr
s CP 1613 HIE TRl F M SGERCEs I, AELLU RIS 00 H 7 24125 NDIS i& Fi s -

o ZEfHIZEH T/EuY (MS, Maintenance Station) WMl 1) #4k F ML 4R 1iL . %
CP 1613 [H/E MS &/ WL CTRMnG) Mg Elies, LAYsn T) Mk,

o LI FIANE TRERZINEE AL Box PC i HBEME RS, K CP 1613 M LRSI
MG RCE:, AT L) Bk,

Bk
PAT LR AL S
e %%¢ SIMATIC CP 1613 NDIS J&HC %%
e Jj SIMATIC CP 1613 NDIS &ML #5414 M 25 B

L]
X MS 2 HLEC TR R LR CP 1613 JUTIKLED IR,

22345 SIMATIC CP 1613 NDIS i&Hh 52
WARAEAE ] CP 1613 [ PC 3 FHFTLL R B .

1. EFRR TR > “BRE” > IR > AR .
REFTIT “ABIMIMBRBEAT” X TEHE

2. E‘T_E‘ “‘F#‘/L}:” R

3. M AEEMNE “ &, ffFCIERL” (Yes, the hardware is already connected). #iili “F
—2” (Next).

4. WHIFRFESE “AINBHELE” (Add new hardware). #idi “ F—27 (Next).

5. W EIEHE “ NFIK Pk PR T 3h k1T %3¢ (Select and install hardware manually
from a list). .5 “ F—25” (Next).

6. MABIEHPIER “MLERL A" (Network adapter). iy “ F—25” (Next).
7. EPEELLN&H:
- 1E “iilliER” (Manufacturer) X8 HH R4 H “SIEMENS AG”

- {F “WLKIERCZE” (Network adapter) X7, %4 H “SIMATIC CP 1613 NDIS i
fic#s” (SIMATIC CP 1613 NDIS Adapter).

PC 7 5L
PAETE, 2007 4 9 J1HE, ASE01235050-02 101



ZHE PC 4f

4.5 1 PCS 7 KR z)f2/7

8 $‘$ .'(—F J_I:J’ (NeXt)
9. i “F—” (Next).

AT 3
10. 40 it “ﬁ%ﬁﬁii” ” (Hardware Installation) XPEHES s — 204 8, 48 H Windows #ibrillik
IR, TSGR . Hil “4kiede” (Continue installation).

1. 9.8 “528%” (Finish).

NDIS 3 it % 22 25 56 L o

& SIMATIC CP 1613 NDIS ;& s A M4 i B

102

WAAEAEH] CP 1613 1) PC it EREAT LA N R

1. ﬁ?@k% T4 “FFR” (Start) > “#&E” (Settings) > “F#EHTHMR ” (Control Panel) > “ M4
i%#” (Network Connections).

BHTIT “M %" (Network Connections) X EAE .
2. WA “HE” (View) > “PFE4I{EE” (Details).

3. Ak NDIS J&EL A “SIMATIC CP 1613 NDIS i&fil % ” (SIMATIC CP 1613 NDIS Adapter)
Rk

A EPRES RS “EdZ” (Rename). A — MR IEAFR, B0
“CP 1613_NDIS_Adapter_No_1" .

EREIRFER i “JBHE” (Properties).
4. EPEER; “Internet H1X (TCP/IP)” (Internet Protocol (TCP/IP)). il “J@ k" (Properties).
FFTIF “Internet #pi (TCP/IP) JE4E” (Internet Protocol (TCP/IP) Properties) X 1 AE .

5. @ “AF R IP Hidik” (Use the following IP address) & iEHE.
A

— IP Mkt
- TR
6. i “H#iE” (OK).
7. KM ¢ (MZRIER) JETE” (Network Connection) Properties) % I .

BEISRE Y FH NDIS i e 2% 1 19 2% B

PC Al 54%
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2k PC 1%
4.5 % PCS 7 2 I =) F)7

452 PCS 7 M in & R shfEF

4521 PCS 7 I In &I shFR e

TR/
WA PCS 7 (k@ E, “PCS 7 T.HAH” DVD L in gk s fe 3 il A 1] .
B 0 % 2% A IR B0 FR 7 iR
A Wi WEHFRFFE “PCS7 THA” DVD | HHnfsa
LEAE
HA-PC 5% | Matrox £ Additional_Products\ Drivers\Display\... | “ ‘W{ii#if% VGA KE¥
A AR VGA R sy (VRS 04> 7 iRy
FEEZER (R | A SRR | 2238 PCS 7 IS LT HEE) | HATM GHEH RS
Kikw FEJTF o PCS 7; #iFRuh)
FEfETRES | PR AL E7E PCS 7 Toolset DVD H — {7 | “Hi{lEiE 5+
TR EbavE Windows 2l [ | (UL 106) 7 oy
i3k DCF77 4 | iiazii iR | Additional_Products\ Drivers\DCF77 | “Uifii#if DCE77 #2155
BRI S (G4 107) 7 #o
BHE SR | 22 PCS 7 I 4x A5 COM #%11 | WinCC 176 A%

PRS- T 2 2% T 75 R IR B R
AlfE
Additional_Products\Drivers\chipcard
TEF USB it 1K [ 5 28 1 SR 5l
T,

PC 4175 5L
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& H PC 7f

4.5 1 PCS 7 KR z)f2/7

4522 T EE %2 VGA BlEk
LT S A 0 n 4 P AR 2 [ 7% 4 PC 3t 1Kk 52 22255 Matrox multi-VGA &7

% VGA B+
FLE PCS 7 119 PC 3 A3 L R EE -
e G200 MMS (IT1i%5: BES7652-0XX02-1XE0 1Y, 6ES7652-0XX02-1XE1)
o (G450 MMS (iJfi5: 6ES7652-0XX03-1XEQ &f 6ES7652-0XX03-1XE1)

Pi. B4

Matrox G450 Dualhead

Matrox G450 Dualhead EIJE-R AT 1 T multi-VGA AR IALE. WAL ETE R,
WAEEH] “ Az hilRE 17 (bus mastering).

EhFET
WIRAE PCS 7 V7.0 58 kit A 44 ] G200 MMS multi-VGA EEFR, #it i 1]
Matrox 5.96.005 UXZIF2E7 . BLIKENFEFAL T “PCS 7 Toolset” DVD Lt Py~ i ”
(Additional Products) > “Ixz#£/3” (Drivers) > DISPLAY > Matrox_G450_MMS >
XP2K_596_005.exe {3,

A TAE

—_

. KM PC i,

2. {£ PC ¥ E2¢%¢ multi-VGA BJER, EEEA PC S FA & 6.
3. e 4 T A 3 Windows (Windows J& 3% F8) .

4. ERAEHBDAN GUAEED WREEIE, HEa.

- fESIH M (My Computer) TREESZH T, IS @4 “J@#E” (Properties)
> “IFE{4” (Hardware) > “¥#&EH " (Device Manager) i£+% “ ¥4 E #i%e” (Device

Manager).

- TE “WAE AR (Device Manager) 1, AR “EJER” (Graphics Card) 2% HIHi 4 4]
B+
VLA

W SR VLS AR O AR R, U5 BT AR AN OB 2 B2 B B B R

PC Al 54%
104 EAETFF, 2007 4F 9 JIhi, ASE01235050-02



LR PC I

4.5 % PCS 7 2 I =) F)7

5. EFAZNHENL, (e PC ulif¥) BIOS " JE K 5k PCI.

L

PC i 3 8% F2 Tt BIOS.

7F BIOS 1, #EF “FE” (Main) > “JE8hikI” (Boot Options) > “ B r#s” (Primary
Display), #R5¥% “AGP VGA” Bl “PCIVGA” .

7E BIOS HiEH “Egh “(Advanced) > “ EE AL E " (Reset Configuration Data) >
“J2” (Yes) HE PCl mgkdliz.

{347 BIOS "I TE N, FHAE “VGA %" (VGA compatible) Windows #5 F JH &350

1. 223 multi-VGA EIE-E RS .
2. TR L.

3. BJE, FHERE multi-VGA EIE-RINS5L.
HRW B E L5 R, a/2% WIinCC 15 B R4

PC 4l 51

“WIi” (Options) > “ I Fi#EHli% I ” (Options for Process Control) > “OS Tii H 4k
2%” (OS Project Editor) > “ 4y & LA (Split Screen Manager) > “Multi VGA 81”7
(Notes on Multi VGA).

“IRAULH” (Release Notes) > “idFE# i1k ” (Options for Process Control) >
Multi VGA

B BA
A7 22357 Matrox KIIE RIREIFEF G, “Matrox i %e)m1E” (Matrox screen properties) 4
S ioRAE “PEIIR” (Control Panel) H.

BT, 2007 4 9 J11R, ASE01235050-02 105



24 PC 3

4.5 1 PCS 7 KR z)f2/7

4523 WIS =

fEi
A R BRAE R S R . R RRUERR AR * wav TE S SO AEH P AT B AT R
SR
2k
o LULHE R,
o WAV UL L
o WAV S Rk g i R s 2 A E AR )
e \%¢%¢ DirectX.
7
1. LML “TFER” (Start) > “i’E” (Settings) > “F#4#lE MR ” (Control Panel).
2. Xl “FEE SR (Sounds and Audio Devices).
3. EF “HH” (Audio) EIR .
4. W\ “ERINTE” (Default device) 44 FeHE ik 48 /5 S,
HEZER

HRAZHEE IR LTS FANEZER, SHEASTN GEREHIRS PCS7; #1ER
vh) (Process Control System PCS 7; Operator Station).

PC 214 54%#
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2k PC 1%
4.5 % PCS 7 2 I =) F)7

4524 WIS DCF77 BIKRS

DCF77 B RS
DCF77 #4507 L TS

o /3K H % [F Darmstadt Mainflingen Physikalisch-Technische Bundesanstalt ) DCF77 % i%
BRI RS

o TS S5 PC i RSN T L
o AT S IE RGN [
BRSO LR ) B A T . BRI PC U — A 4730 L1 £ 55

L]
K “DCF77 $RMoiiss” MRSy A2 7 i N AR PR R AT R (K ANl DCF77 B
PC.

Eok
DCF77 #lastbith 283 PC uhf #4756 A .
puR
1. ¢ “CS 7 LHAM” DVD L, ¥ rff3% Additional_Products > DCF77Client.
2. A7) “SETUP.exe” &%,
3. BRI B st T AR P A R
PC 4145 5420
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L HE PC

4.6 iF I

4.6

4.6.1

HEARE

108

VFHIE

Yra] fIFZAL PCS 7 #44:

NERII T A R E LR
ARi& iR
VFATE VFRTUESR AL ™ S BOBCR o AR KT 208 «

e Col (VFAIEIEF)
° ltFﬂLﬂ:%%E

ColL CmJHIE

CoL WAEVFAIE. 7 it S B8 B VF PTUE BT A & BRI AN BAAEHT -

S ED)

VERHIF 2 A VFRTUER P VA e “HORFIXZEA”  (BHOY “H P rERE” ) .

B BRUEVF IR “BARRIEEX” , EERZTIHRANRIER. &5 VFariEs g
A

L

FEARHR Gy s BATEIAE VAT E R, B> S B “ BB

PC Al 54%
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LR PC I

4.6 7k
VT IER R
AV T E 34 F S AV T 2R T 2
HAVFITIER A E XTAE S DA PC i L s e R AN CHE . VF TSI 52 SUAT K]
S AL e A4 8 P«
o W HIISEAVETIER A R
B AV AR i
YT ERCHETE, PTG SEBL EREIARPE. ETUEE B T Ao
[LESE
PEE VT FEFICVFATE, AT(E KA O FE R SEHL LA e, ATRRp o
ST B UL L.
o WV RTUER AL T
VAT i
AR E BT, 0T LR S R
VA1V T PV T, kP 000 1250 BL T B
o Ol R
ALV BT, k00 1Y 250 BL T B
o Gl SURIE T I
o Bl SRRV 2 R 1 T
PR (B RAGEEIISRA r TRUR, SR Y TR R I T 1.
WU VT PB4k 000 1Y 250 BL T B
o flt, BE 4R
o PRRMEFIZ R R
o JHFRHRAIRIE (St
HeH I VERTREA | A PHLIV ATE, P P 205 S o s S P 26 2K O M
WOR VT PV, k008 1Y 2050 BL T Wl
o Gl SLRIEATI ]
o IR SRRV 2 SR R
HERE: (BRGNS o TRIUR, SUREor i TR R T 1.
VT BT, T LR S B T
THA VT BTG TR B A 1 R YR A ok
o AEFITRGEATIE, DR CIH” 0 x BRI ATIEREHOY xor A UL L
AR,
o I, HITHONTHORG N, T AR BT T
B
JEARBTAT 7 SR VT s E 1502 i PSR, ARG ) TR P i
T,
PC 454

EAETF, 2007 4F 9 Hhi, ASE01235050-02
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& H PC 7f

4.6 7F ] ik
TV ATIEE K PCS 7
WHs PCS 7 LFE T AATHA A AT RRAAE T, AT 14 K.
W
H AT Z AT, AT a0 Gion) B
AR IR R UE S 4
W R IRAFRE e ANV TUE S, (HOCIRAE M 2% P 3k SR — P IR P “ AR T,
FREN “B R VFATIEE S
B S L AT IR HLAS
PR VF RS I A5 il B P AT Gl PCS 7 REE2RE P 2348 fEX
ASrh ey BT A
TR
L]
FERFUCZRIENIRVF nUE S YT, NS A PC & S SO 25 o
PRy b AR FUVE AT UE B P IMEAE (0 'S OR3P A REAL IRV AT UE B B, TR AT e 2 i SR AL R A 41 2 )
o T A 0 25 [ DU o
EXER

o FN CHIAMLFIEEHES) (Automation License Manager)

PC 214 54%#
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LR PC I

4.6 FHF
4.6.2 UNA] £V AT IE 25 4H
R~
LA VE AT E B 30 501 1 i) i B A A
o LIJE IS IV AT [ VA i 25
o AEREATE T LS R R VT ) 0 AT
A BRI IR B AL B
o VRT[iE® B
o AU AF AT
o PGS MTEE A T
o [RSENELE (filin U 4%, TdE CD 2k DVD)
VAR AL 2R T
FI 501 2 A S AR T UL T4 4B 1] B (R0 770 o7 8 IV 028 2w i 25 1) 16 101«
o i
o ETPIHIRG G
o BILALIL
Bk

H a0 i af il 5P 75 2R 3o

HE T TR ) AP R

1. {FRSEs a4 “PLE” (View) > “&EE” (Manage) ik FAH N ALK .
LEAE A ORI S HLBITHE AT R L, TIPS AVE IR S B AP A
LRSS F QRS IT B 0T S b, ST B AR B Sl vr vl TE 2 R K A i A7

WEPEVF AT UERE D], Ff bR A8, RV I E 25 4 5D 2 S48 IR SO AL
&L T VF AR 51 o

A w0 Db

PC 41 584
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ZHE PC 4f

4.6 FaIF
BY U FRG NG T R E D B
1. a4 “AE” (View) > “EB” (Manage) £ B AN ALK .
2. B A ORI RN ATIERE R EAL L, 7T B D) T B A A
3. WEEENMA “HiE” (Edit) > “BIE” (Cut).
4. ERS H ORI SEALE T ERE VST, T TR 2 AT IR S AT A
5. RS ‘4R (Edit) > “H5Ns” (Paste).
RIAL I 7%V AT IE 2540
B ERABIRIR TN B e P B
H 01 3 1] TF P A AR A B AT WA AT 28 eV vl IE S5 4 A%
CEEMPY Y3
P
VE R VE T E B 5 24 R G B2y s AEARIRVF A UE B, 270 HFRIKEN 2% F =B bniR ol
“IRNT RS VIO EERIX AR, 5 S BRI AT IR S .
AR VF TR 2 4H
IR 501 2 B iF B PS4 A BRA VFITIE 354 (BB - 0 “VFaliE 2540 0 ] el
fiE” .
PC 214 54%#
112 PAEF A, 2007 4F 9 J1 1R, ASE01235050-02



Z2F PC 5ff

VFAHEZ

PC 4l 51
HAETIE, 2007

26 4% T 180 )V T I3 BB AN

4.6 7k

PCS 7 L) (RSN EAT Y e TRUMS, . #4E bk, SIMATIC BATCH 3. B2yl T
fEuG LK. SIMATIC PDM A8 7= S el Ul ol H F AR B 4540 . nl 8 F IO sl ok

JEIX AR EH o

VtH

FERICH, B R A E R BRA  d, JRA T A R TR AT E B 4

£ PCS 7 V7.0 SP1 FIH A, S HEAT BB N 51 G IS0 ik FEx] 5

(PO, Process Object):
CIEENEAERSYRES

FRERT ARG O T PR RGN .

TREE AR A A VFATHUEZR B
TR T PO s K4l o PRI ES LA fExt S AL
(ES, Engineering system) . 250
e 1000
e 2000
o BRI
R PO f K4k o HARRIE B G R I RN 5
SIMATIC 3 | (h%5) - (PO, Process Object)
e 100 o XUEGVFRIIERAAM VIR “IH L
. 200 ABRAVF AR o
o [ ES LPrT AS YraliE & 4L
* 250 JIEFLE
e 1000
e 10000

F 9 AR, A5E01235050-02
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& H PC 7f

4.6 iF I

114

WREEHRAH 4 VAR5 R
e (Eak PO f k% o FEAHTENE RGN 5000 4~ PO
(OS, Operator station) . 250 o G4 OS % Bk 8500 4 PO
e 1000 o IRE 12 MREES, RS AHRE
e 2000 5000 4~ PO, &34 60,000 4~ PO
e 3000
e 5000
e 8500
0S % 'L WinCC RT PO % ¥l
o AR IR S A WinCC RT PO %& F#iL
A VAN AR B [ e KL o — OS g apfb 2 v H£Y 1000
(OS M55 BRIP IR |o <512 IEES S
AR 4% 4% e 512< 1500 . *ﬁ#ﬂﬁﬁ%%ﬁuwm%ﬂﬂﬁ
12,000 NP5,
o 1
500 <5000 BT OS M4 5 M VF AT 0 2 i T
5000 < 10000 512 NLUR ARG AS B VP al e . o B
« 10000 < 30000 RUE 2 A, A BB BN R
BT TR R,
e 30000 < 80000
e 80000 < 120000
P T A %%ﬁg%%ﬁ 7 PCS 7 Tl 5 o W WR iy 4 4
(MS, Maintenance station) S BRI SEHT IV TR TR 56
e 10 YWATIE” .
e 100
e 1000

PCS 7 OS Web i

Web &/ Wl K3
e 3
e 10
e 25
e 50

OS Web JI#45 %% ) Web % ) Bl

Web 12 Wi & Ml K2
e 3

BATCH ¥ (flb/:7~
UK D)

KRBT (LT #I0)

e 10

°« 20

o 40

e 100

o BATIR

PCS 7 5 H H It st

o ATACEKHICEI YT BATCH IR 55 4%
A A O

PC Al 54%
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LR PC I

4.6 Tl iF
R R A VFAT IR A R
B TS (e | R AR ST R ISR (MR
FEhD e 30 M THEEF AR, AR
.« 313100 30 NGB AR LA .
e 101 | 300
PDM ICPNTE S T2 A B
o 4
o 128
e 512
o 1024
o 2048
o BATBRH
SIMATIC PCS 7 Box PC | T.#2 PO Hk%L: Pl ES EAT A AR 4 ) 4
e 250 HXRIFEFR S (ES, Engineering
. 1000 System) N Z(FE, WSHILR
e 2000
AR R | PO SRR AL TAENE R G 2000 4~ PO
e 250
e 1000
e 2000
T3 PO K%k IXECVF B H IV IR R A “oh 3L
SIMATIC 3 | (FR%) - AHRVFAHIE”
e 3x100 K LIRS (ES, Engineering
System) WE L EE, AIZH Ik
PDM IE PN EAE %44 SIMATIC PCS 7 BOX 416,
o 4 T 128 P&
o 128
YEg AR, | B AR IXEEYF A UE B Y T IE AR <R
L) - I AIIE”
e 10 AR PR B 4 AR B (MS,
. 100 Maintenance Station) {15 2 {55 &
BATCH PN i X F4:4~ SIMATIC PCS 7 BOX 416,
(L) HI8) - BT 10 AT
e 10
B | B XF ¥4 SIMATIC PCS 7 BOX 416,
e 30 BT 30 MR

WAEE AFIER

A RVF AT IR PR

PC A5
EAETF, 2007 4F 9 Hhi, ASE01235050-02
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ZHE PC 4f

4.6 iF I

4.6.4 T SIMATIC 35 HIEFER %

AS K AE 4

R

o

116

FiAT SIMATIC 2 Bir (R VF RIS I AT H (2T H D R IR 25 )i Rend 5 B 4

n#k AS I, R TN )i Rt RBEAT TS LUR DB R A e[ v 550 H i 4 R R 5
o XMTZIH, &L E I TS S EORR e .

LLTFHU M PCS 7 V7.0 SP1 & FF a4 24
THE IR AS R R R B, ARG T RS CRl S e & 8D TR 25150

I A S VE AT R HE A RV T UE 4], e SIMATIC 5 H 28 Fh il il S Py & “ 3BT

(Optlons) > “E®” (Charts) > “idfExt% 4158 ” (Process Objects Statistics) K it4% ] [
CFEINED IR x5 5.

RIEAE SIMATIC EHIERT PRI S (ZTH. TiH. SIMATIC u) B4 aliEE.

SIMATIC & #48 CHTITF-

1. AP IESEZIH .

2. PSS “XEIR” (Options) > “E%” (Charts) > “EfEN %4515 K ” (Process Objects
Statistics)-

BT RS G G115 K (Process Objects Statistics) X 1ifAlE .

PC 412 5L
#AETFIF, 2007 4F 9 JIh, ASE01235050-02



LR PC I
4.6 #FufiF

“HFEXH G E R (Process Objects Statistics) X 1FAHE 7~ CVH AR 8. LA 1KVFn]
WEAT A F O a] - BL N RS I FEx 52

o ZIiH
* JiH

e SIMATIC 3k

Process Objects Statistics

=l ES [Configured: 3199] [Booked: 31598]

= &534 [Booked: 271]

Y =2T | [Boaked: 271]

-1 4536 [Canfigured: 301] [Boaked: 300]
L AS36 [Configured: 301] [Booked: 300]
- 4538 [Booked: 37)

‘. 4538 [Booked: 37

- 4540 [Booked: 563

L. A540 [Booked: 563

- 4546 [Booked: 511]

L AS46 [Booked: 511]

= 4548 [Booked: 1516]

_ L SR [Boaked: 1516]

- ES_Pri [Booked: 0]

-- 151 [Booked: O]

- 052 [Booked: 0]

G

1]

1]

1]

Axaillable license: 10000
Currently ztill available; 1600

Help |

PC 41 584
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& H PC 7f

4.6 iF I

4.6.5 T AR TS RIS RE R 5

T TREB R AHIE R
T H A AL R Gt nliE i OS ML I R Xt %

FHF TR IV Al A Tt — @ SR I FExd %, o 4E CFC Al A4 “TiH b
IR .

AL LA R I7VE T S A A I R B K
1. {E CFC FHTIHEATIE &

2. PSR RaTS “IET” > “ERTIHERE .
BT “ RS NEEE " XEHE.

3. iKY “BE” > “GiHERY -

“IIREXS (PO) [X]” (Process objects (PO) [X]) HI%k H AN Tk 2 0 AR W on e “ i H Hh it
X% AR . FEIEART N,

§54S7 Program(1) (Statistics) -- color_gs_Pri__Prj\SIMATIC 400(... [Hj[=]

#- CFC

- SFC / SFC types

-- Resources

-- Time stamp

- Process abjects (PO} in the project
[Z:u:un’r'iu_n‘euj process objects (PO [430]
Scope of Authorization [PO unlimited]
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LR PC I

4.6 7k

4.6.6 VAR R IR B

A FRXT B VF AT UE RS £
eGSRV T IE36 307 501K 4
o RT VFiEE4]

RT VRl ib# P eV A GaAT ARG (Fia)) BRI WIinCC. RT3
U, FURELEAT B AR I T B A A8 T 4 45

® RC VFHiF#%H

RC ¥FiliE# S AV AR GEATR50) F4ISRE A (D FREIHLAEF WinCC.
VR AT IE R YA A n] DL B B ol SR/ E A I AL I 8 SCHCR 1) S ST RN 4
fiiH] SIMATIC BATCH 1135 H 75 22K & (1 A0 4

VL VT
B VR R E R A A m] DA I 0 D3 il RS BT SRR R VA B FEAC A B s T U4 512 A
PHE VAR

EES OS T H rh ) YRS BT 75 R VF T B8 IR T oA AR 2 S RO B H

WAHEFARS
VFAES ] RT (X)/RC (x) & XAV I ISR A A HH
541 1: WINCC RC (5000)
T BV ATIE £ (RC) ATEAT LR 413
e %% 5000 il FEXT %
® % 512 AR
£ 2: WINCC H /7 J34% (10000)
MWLV RTIE A, AR RS A AR IR 55 a4 H A A4 (6 2 H B9 I %1 10,000 4.

OS & P HLHVF T IF % 4H
OS % Lt FEfi= (WIinCC RT PO &/ ML) T H il iF 554,
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& H PC 7f

4.6 iF ] iF
R

OS T Fl A4 EL4E WinCC I91 [ 4 B th 4T FF
P&

W A SIMATIC & 28T “%ii¥ OS” (Compile OS) IhfE, WIHTLAZE WinCC 5 H
EHAP T CAST RN R EE

e X S K% H

1. 7E WIinCC Jil H & #2845 OS:
OV AT FEN S 5 H SR e i AEA R T .
T AR RS “578 AN FERTR” Sz

£ WinCCExplorer - D:\Projekte’\PCS7_¥7004,0s2' wincproj\05{13,05{1).mcp [H=]EJ
File Edit WYew Tools Help

[ E=A N S

= 0 3 Marme | Twpe ;I
gk Comnputer @Computer Computer—lll

!ﬂﬂﬂ 'Eag r\.*lana.gement j ";'T | : »
Press F1 for Help, |Process objects: 578 | License! Unlimited P

i JARE R % B

1. £ WInCC il H & # 8T “AEid k" Mias.
CAH A RS % H SRR HEA B
T AR R A 129 (3£ 10,0000 ANAARGAEL 1) SE 4 o

B Tag Logging - [0S(1).mcp] =]
File Edit Wwew Help

Archive name | Archive mode | Last change |
)l Svstemarchive Process Value Archive  10/19/2006 10:51:56 AM

| g Archive Configuration

Feady [Tags: 129 [ 10000 2

PC 214 54%#
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LR PC I

4.6 7k
BYREBHITY R
A LA BRI i m] AL A AR A O K H
Sl

WUERTTELAREZY 20,000 ANERSE, WIBR T HAVF R UERPI5h, 622246 T 1500 2 30,000 />
PRSP AL o B T FEATVF AR PIAh, R 2 DU AL

o JHT 512 %] 1500 A AT R AL
o JIIT 1500 £| 5000 AL & IR AL AL

o JiIF- 5000 | 10,000 /™l 4125 R4 {H (AL £
o T 10,000 | 30,000 A~y 425 AU E HOFEAL L

WAEFE AL

VtH
UERFTIT I H S M T A SR S H AL, W OS Fifre Hah U B i

UWIERATAE RT/RC VFRIIE# ], % P L AR 28 Se vl i o R i T A A I R x5, A A
JIR g5 s A AT A A R B EH .
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&Fe PC i
4.6 iF ]l

46.7 THE R R AR R S5 AR L R B2

faifr

PCS 7 T.) iy OS JMd5&s i HAE AL R VARI R 545 LT IR . Ty OS JIRS5- & RSB
AR VERT A (A H

T R YA A AR 552 BV TITIE 25 4R
o R YA R 95 s it S LA VR AT IE B B
o #fE OS & HUIMVFANE®H]: WinCC RT PO %)}
e “StoragePlus” I n]iE#%4H: StoragePlus
PRI iR 55 4. WinCC i 554
AR WIinCC 44
EE IR % : WinCC DataMonitor

ffE OS M55 ae RS E % H

1. /£ WIinCC Tl H A HE 8 h 4T JF “Aximidsn” gwikss.
CL2H A AR (T H oA AT R 7 .
T AR K Bt g 129 (3£ 10,0000 ANMZEARYE 2451 .

R Tag Logging - [0S{1).mcp] M=l E3
File Edit Wew Help
JE|J‘$|§'EE |'{9

J QS mep Archive name | Archive mode | Last change |

02 Timers J)Systemarchive Process Value Archive  10/19/2006 10:51:56 AM
Forchives

| g #rchive Configuration

Ready Tags: 129/ 10000

2. ffiE T OS MR55 A ARIE K H .

L
WERAEHITUAY OS MRg5 s, RS ERH L ZUnAG -

PC Al 54%
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2k PC 1%

4.6 7k

4.6.8 RS TR KRR B H (A

%P TR T IER 4
XECVF R R RV UF R AL TP BUHOCVFRTIE” o ey TNV nIE 2R, 23 [ N
VERTYE
o R ICVE rT IR B il I M e B IS TN 5 (A=) .
sZf]: Maintenance RT (100)
WP AT IR R 08 H Pl — AN TAERS 2 208 100 AMECFZAE. i —ANed TAER B
—> Maintenance RT (100) VF il k%8, Wn] LLiZ K214 300 AMfF2 1+

HACKae At

LUN HATI2 W e ) (LT PCS 7 TUH A0k B8 =28

PC

HALWRE M40 sz #dlD
Hzh1k & 4; (CPU)

434 110 (ET 200 3#4)

HATLWiRE 1 I35 5 #

SIMATIC & s O 4T .

“OUIEX%” (Configured Objects) X HHE L/ CALERISMIR G (4% 1EH .

T MR ERELZIHE
YRS a4 “XBIR” (Options) > “TLJ E4” (Plant Hierarchy) > “ BHAN %"
(Configured Objects).

BATIT “C4 A% (Configured Objects) X iEHE

Configured Objects (3283:5203) |

\ij) Your configuration cantaing [ 126 ] diagnostic objects.

R
b
1.
2.
R
PC 414 5 E2H

EAETF, 2007 4F 9 Hhi, ASE01235050-02
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ZHE PC 4f

4.6 iF I

46.9

5 BATCH 35 ) 8 63

BATCH i i) 17 AT 1k 25 47

AP SV R E S R S R 4 IR BRG] A3 B s B T BATCH IR S 25 1K
FT 10 o

5£f5: BATCH Server (20)

BATCH JIik25 2% (I VF RS B 2 v LLH A 20 45T

£33

o

H & SO AR R 5 -

124

o o ~ w

SIMATIC & #Las LT F -

. {£ SIMATIC & Hi g8, EPEI R CAASRcmZ o H/H .

LR RS “IET” > “SIMATIC BATCH”
“Z07 BATCH 50 X 1hHEST T
TERTERLE e “BATCH i f#ic” Sepbk.
12 “RERIT” Hoy R, il “REAAE .
£ CHE” dlrp, g IR RLLHE,

T R T VTN /31

H &£ Internet Explorer 131 JT .

R R AR B g iR R A AT A ENR, WFREEIERR, e Aok
FEXS G

RSP EATHE R, WHAER P “ o0 bl M RBIZIUH TH o S A1 ok
FIIE I A SRV AR B T AR Vi RIS PR S 4L e

T Hou & EE N 2R

<process cell name> | 11 LR <date, time> 0 MR, 0 ik

% ' ID iR B b R It

PC Al 54%
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LR PC I
4.6 #FufiF

4.6.10  IFEBEREHTAEL R ERZE

G SR U MR (R T 5

X1 SIMATIC B2l M Faiat, SVFrTHSCHEmshiie s, mAE CAl&mie . ik
BN IIE B AR RO R T A

52f1: Route Control Server (300)
Vb AR A2 T R 55 45 VI 25 ) SR VAR AR R I 380G 300 A 42 .

T 2 B A2 A PTHIE
AR L AR ASAT s i A 42 T I 2545 TR [ B s P i A2

VTR 1A/ — SRS BV TIE R4

L]
U SRAE JE B 0 ) B A T IR 45 S ASH U 21 S5 VF 30 100 B 300 ANMEARIVF Al EAEEH, W) nT [] I 3k

IR SRR i A ) B R B R S I PR S R S5 s AT IR ER 31 4> 2 101 SEliss 301
AMERIE R, HARRE D 2R S B D VRIS P el PR BRI RN SS A e AR SR A

VFATEE AR/ — AR S5 2 VP AT e 3 8

R ERAR PSR 55 4% LR 2V RS B, RS54 e 2 A FE 300 i dz KRR o DA
EEARPEBIIR 55 4 EBATR T ARG LI RNIE R, Frel e g okt — RMiEs
AVFAT IR ] DR SHRAE R SE. g Aeda il O BBV Al e .

HVFATE
L REVF AT IR A R AR P IR 55 45 o
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AT IT, 2007 4F 9 J1)%, ASE01235050-02 125



& H PC 7f

4.7 HE# PC 3
4.7 & PC ¥
471 % PC uf — f#tid
f&j /v
27245 PCS 7 #h 5, M Em R,
Bk
o &4 PCS 7 A-AI PCS 7 fififf:.
o UAREIH I PSS o
i HA
ik SIMATIC PCS 7 BOX, iE#HFM IRt &4 PCS 7, SIMATIC PCS 7 BOX)
(Process Control System PCS 7, SIMATIC PCS 7 BOX)
& BWR
T REfE N TR (ES) 2. FEFIINA PCS 7 1 H T A sh ik R 4R PC 3 (OS.
BATCH) , 57Efrfy PC &l EHHMTLL PR E .
FE A Y T RE MG b A BT IX e B
B NE
1 1 SIMATIC Logon 17 “Logon_Administrator” Hi/" 20 (5ihis 127)
2 )OS H 4t SQL Vi AR (Tifs 128)
3 M P BEETE S (MU (g 129)
4 WOEH AR (TTiE 131
5 EA ARG P44 PC Y (WIS 133)
6 WEARMEM ISR AS (TUhs 135)
7 S PC Mg LR Az TR (ThS 136)
8 G VBT . IVERMET . kS (TTRY 138)
9 s PCS 7 M4 E (hY 139)
10 % Open PCS 7 (Bl kB & (Tihid 140)
11 B AL PC R4 (TURS 141D
12 K 2 4 R E PC b (TTHS 141D
PC &5
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LHEPC B
4.7 HEA PC %

4.7.2 tn{a & SIMATIC Logon BJ& ] 4

f&iIr
WA PCS 7 1) i H] SIMATIC Logon HEAT U M|y, A2k E “Logon_Administrator”
4.

oy

1. PR AS TR > “RE” > “BHIIR” > “BEETAR” > “TEIEE” .
2. BRI, R RG> CARHA PRI > 4
3. LSRR S “HRIE” > “ErE4l” .
— ARAEH P AL N AT SR G AL (B, BRAER . 4 TR, D .
- WA SIMATIC Logon JjRE, MG “Logon_Administrator” 4.

4. FERTEME T, %HE “RGA” (System) > “AHiH FRIZL” (Local Users and Groups) > “
17 (Users),

5. WP AL “HRAE” (Action) > “FrE 7 (New User), LL7E Windows %44 (Windows i
Fea) halErA P GRS FH P 4.
JEiT SIMATIC Logon & X H F f BRI E SR
o LEMAHS PCST7 NARFHFML E%3E T SIMATIC Logon.
o LE—H PC (BEFIHEND LEI& T “Logon_Administrator” 4.

Ja 85 BRI RAR B

o AT SIMATIC Logon '8 H 7 M 4 A Fe 2 e X Windows 1 411 36,
2% FM (SIMATIC; SIMATIC Logon) (SIMATIC; SIMATIC Logon).

o AR EHATIIM N BCE RIE B, 2% 5] SIMATIC Logon 3E47 15 i) i BE (1 B ] R
PN I CER

FEZED-)
o Tt (SIMATIC: SIMATIC Logon) (SIMATIC; SIMATIC Logon)

L) OS WH, HI 20 LU IR b -
e “SIMATIC HMI” 4
e “SYSTEM” 4

R
P B2 LUE B 03 5 4 %

PC 41 584
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ZHE PC 4f

4.7 HE# PC %

7
1. $TFF Windows & J5 &5 M Be
2. FEMEME S, EFEAA OS IH KIIRshE .

3. BEFERH M4 “ICHE” (File) > “J@HE” (Properties).
BATIF “. @1k (... Properties) Xf il .

4. WP “4z4” (Security) KET .

5. @ “SIMATIC HMI” 1 “SYSTEM” 4 iiRAIH, 1ERHANE] “4siH 4" (Groups or
User Names) #1|:& 1,

6. A “SIMATIC HMI” F1 “SYSTEM” 4.1 A #HL.

4.7.3 e > OS A 7 4Bt SQL 5 I A R

Microsoft SQL Server 2005

i+ Microsoft SQL Server 2005 ASCREH NI 41, B2 “SIMATIC HMI” H 41
(KT AT B B s N2 LR P 4l

“SQLServer2005MSSQLUser$<RECHNERNAME>$WINCC”

R
o C\fid PCS 7 B A/
o HREBEAH I “SIMATIC HMI” F 41 I8 i
o M/ CL LI R G4 E 5k,

i

1. PGS “TFIR” (Start) > “¥E” (Settings) > “#4#|HMR” (Control Panel) > “ &3
TH” (Administrative Tools) > “i+HHE#” (Computer Management) X T54E .

2. fEMTEALET, e “REG” (System) > “ZAHiH 7L ” (Local Users and Groups) > “H]
J*” (Users) 013k .
I AU 7 28 s AR PRI B

3.t OOy BRI T A A

4. TERTERLEI, kR “RE” (System) > “AHiH P RIZL” (Local Users and Groups) > “4H”
(Groups) (119,

P A A1) W AE AN B o
5. L “SQLServer2005MSSQLUser$<RECHNERNAME>$WINCC” .

PC 214 54%#
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L H PC I

4.7 HEA PC %

6. WP AA “BAE” (Action) > “HINRA...” (Add Member...).
FFT I “SQLServer2005... J&PE” (SQLServer2005... Properties) X} i&4(E

P AN (Add) 4L
BATIF “IEB . HHEEHLE4L” (Select Users, Computers or Groups) X 54 .

. ¥ “SIMATIC HMI” H P 4B R E
“SQLServer2005MSSQLUser$<RECHNERNAME>$WINCC” 411 F i o

~

oo

EZER

LT WinCC 158 54

4.7.4 AR P REES (MUI)

fEisr
% T UARAR T A PCS 7, JUGIAT A0 7 BB LA AL R AT
E¥?s7¢,ﬂuﬁiﬁﬁﬁﬁﬁﬁﬁﬁmﬁﬁ%é&ﬁﬁuT%~ﬁ%§<m&?m§%m
wa) .
o
o i
o ifi
o kil
o BAFIE
o PHIFH

Bk
LREAT 2 D SR A R G

i B
TE 2R Je RS IR 45 2% K1 StoragePlus i, 4 8 s 2 R o & i) —FhisE 5 .
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AT IT, 2007 4F 9 J1)%, ASE01235050-02 129



& H PC 7f

4.7 HE# PC %

i

130

PSRBT CTFERY > “RE” > “ERIER” > “REMEFEMm” .
. BEFE “IXHRiET” (Regional Options) £

A 5 PCS 7 L) MHTIXLLBE .

CERE BT EDIR,
L AE CSEPARDEHEHE P E P HE S 7 (Language used in menus and dialogs) X, MRz

HIRKEH P AT 5

B
FRBIFEHE (L 3 EL S

C WEREDEGA T (BT ENZE S, ERATEL R DR

- JEFE A IEIR.

- W 7 “JE Unicode FEFHITES " (Language for non-Unicode programs) X1, M T
PrHRAMEP L P43 PCS 7 fT i HIME =

- #%: 7F “dF Unicode FEFEMIE =~ (Language for non-Unicode programs) X141, M
PrYRAMEPIE P23 PCS 7 FT i HINE =

— @ fE AL TR ” (Code page conversion tables) [Xi#H, ik H I PCS 7
RV RO R S TR HE

- 7F “ERUH K ¥E” (Default user account settings) XA, b kT BEE N
F T 2400 bk ) AERR P ECE SCAE” (Apply all settings to the current user account
and to the default user profile) & iEHE.

- ®E)iPC.

VLA
LR LR R S5 2 A0 StoragePlus Ji, B ) 5 MR A T HIE S .

PC Al 54%
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LHEPC B
4.7 HEA PC %

4.75 Gn Ay 20 28 AR R

fEisr
DR A L LR TA13S PC 3l B IR

Tt B 2% v el £ ) P 28 T4

L]
ek PC sl IEA LI PC SR R TARSE R SE, MIAFTEIATLLU R P IR,

1. 7& Windows ZFJ5 BEAS IR B AL ik $E PC uh “IRIHIN” .
2. %# “SIMATIC Shell” i3k,

3. fE L PR kR “BE” .
“EPEL 7 RAEHEST T

4. 7F “MLERLH” (Network Adapters) 2T, 26 PEAE i i 2k bt A7 10 1RSS4 F 1 3 TR
PR,

5. Huli “HiE” (OK).

LR SUIPN YRR R Y A b A G S TRS) A s O (kS S

6. B B R A .
A 22% T G ot K 2 BT R AR AL o

PC 7 5L
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& H PC 7f

4.7 HE# PC %
EEILRED
1.
2.
3.
4.
5.
6.
7.
8.
9
ABTUR MK IE AL S
1.
2
4.
5.
132

WIRAEAEP G OS Miss e 2 L TUAER, WAL “SIMATIC Shell” XHEHEFEFE R TUA K
PSR AS. Lt “HiH (Serial Port)” B¢ “ M 455 TC#s (Network adapter)” #2704z

7E Windows ¥ 5% 128 1B T LI i PC b “FRifduflii” (My Computer)) .
%#% “SIMATIC Shell” 3%,

EPRAESC T, RS “WE” (Settings).

BT “ikFELumnsk” (Select Terminal Bus) X1

7t Windows ¢ B 83 IR EAL K ik % PC 2l ¢ “ ki~ (My Computer)) .
%#% “SIMATIC Shell” SC3%,

FERFEE I, PR a4 “TURKE...” (Redundancy Settings ...).
BATIT “I0A%E” (Redundancy Settings) SEHE .

1E “FTUAIKAER AT %% (Optional connection to the redundant partner) X1, k%
Pt

LB Y (OK).

PSR A “TFIR” (Start) > “HEE” (Settings) > “M4&%ER:” (Network Connections).
BT IT “M2%%$#%” (Network Connections) % i HE .

RS B > “HERE”

“CTRBCE” REHES] T

3. EFE “CAERECARAGRE T LR,

R b i 26 Y PCSliREA T RN B A8 ] AR A2 1 “3E8%” (Connections) #1131
TP o b BEIRE I FL A B 2 TH

B

WRAEFH TOUARMIERC S, WL TEAM R T AR T . AR =8 2
FR, WZEIR (LB RS PCS 7; AT ISR %)

(Process Control System PCS 7; Fault-Tolerant Process Control Systems).

LROP A IERC AR Jn B A B IEECR HBLE SR T .
i ORE s SZe_E 10 PC il BEAT I AN BT A H (R 3 7 1 51 2 0

B “HiE” (OK).

PC Al 54%
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L H PC I

4.7.6

faifr

Bk

4.7 HEA PC %

I AEATER G AR PC ¥

PR L) R b, SRS IERE N ERAAZS PC uhiK ) AL
PATLUR 2L 3%

o ) RZ iy PC
PR Bl 43 B X 4% 38 B 2% 1 b - -

— J@id CP 1613 il iHAb B #3012k i PC ok

- T FREM SR SR T B B PC ul (IPRAETT) R4 EAEH] 1ISO sl
L)

* Jiff PC i
- A PC BEPETT I A

K4 “TFE” (Start) > SIMATIC > SIMATIC NET > “414&3%4]4 ” (Configuration
Console) AR ESS

Wit CP 1613 ML HAERM T Bk LY PC ¥

PC 4l 51

WARTT 2% B PC wliksiiid CP 1613 il AL H S UE TR, 1EX T CP 1613 AL BEZL A
(w7 ¥

L]
IR EAE PC ui EHBr 248 T PCS 7 BAF, WIATGEPATATAANLL “ArifE” TFk(K2D

—_

CRRUE”  AERDERLET, R B (Modules) > “<H] 15 )R 2 TR M 4% 1 T

#>” (<Network Adapter for Communication with the Plant Bus>) > “# i~ (General).
ORE” o R TEANELIST PC MBI, KIs TBRE N “PG X" (PG mode).

FERSTEAR I, RS “BEL” (Modules) > “<HT5 1) Rl Hr M4 iERLAS>" (<Network
Adapter for Communication with the Plant Bus>) > “Hiifi-” (Address).

. WEMAE (TCP/IP Hulibs MAC $tuhik, BRSO .

SIIEN

N
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ZHE PC
4.7 HE# PC %

AR HE M BB AL ER N T B & LK PC 35

WREAET) g B 1ISO Bhill, (HAGHIE L IEHC 231K MAC $idik, VX By b vk ) 45 1
Poas AT L~ 2D 3R

1. ERDERLE I8 “Bi” (Modules) > “<HT-5 T Sl I M ZOERLAY>" (<Network
Adapter for Communication with the Plant Bus>) > “Hiilit” (Address).

2. N MAC Hililk, 217 PC a5 i bk

A~ PC a7 I8 i
XIHTAT PC ulithAT LR AR
1. fERERIE T, e “Uiin 57 (Access Points) SCPE.
2. {EA)3k, k$E “STONLINE” .

3. EFEH A 3T > “BHE” .
“STONLINE” X iFHES] T

4. M\ “SECHIEE S50 (Assigned interface parameters) T 741 HEHEFE “PC N#E (A
i) 7 (PC internal (local)) % H .

5. By “#fie” (OK).

PC Al 54%
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2k PC 1%

4.7.7

P&

4.7 HEA PC %

U BEAT AR AE I 2 B BT A5 R BB

U AR T R AR TCPAP s, I 450 T e R A7 BnvfE 9 2 & e s g0 AT B T
155

RS TR > “RE” > “MBERE” .
“IREIERE” STUHEFT TT .

7E “M %7 (Network Connections) X ifHE k£ T H&k.
LRSS “3CHE” (File) > “J@M:” (Properties).

MA iR “Internet T3 (TCP/IP)” (Internet Protocol (TCP/IP)).
Hali “J@YE” (Properties).

/14 TCP/IP it

AR, AR IP #ilk: 7 (Use the following IP address:) & % HE
- N 1P Mk,

- AT

7. ik “HiE” (OK).
¥ E TCP/IP Hiudil.

o o A w N

i PN BUE 2 A P 4 E B AR I R

PC 4l 51

|

wEINF

WERAE ] JLAPRAE R 253G B 2% (1, 3COM FERCES) » U T~ 2ui i 2R (Rl ie 2 L 2 56—
AL (M ETE:  “mg” (Advanced) > “iRgi ik B ” (Advanced Settings)) . DAZAE ] T
NI BT A AN AR AE FH R 194 2% 3 P 245

LR PCST ), BHENHIL—AXS TR, ZAE H i £ 1 T 2 m S M 5 E e 4 . P
WRCAs 2 Jm, Bl “ofiE” (OK) #iiAik e, Rnsas “27 (Yes) #iik “ EF#inL”
(Reinitialize) Xf1iHHE .
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& H PC 7f

4.7 HE# PC %

4.7.8 WA R PC M 4% KA FT SRR 2K

faifr
NAEMZE R BEATIEIN, #OR LN S EO TP M1y s =, BB R 2
o flAmidR

o i

L]
i Siemens B M) WCE, ARSI S Ea BRI CAPIRD .
A b0 P48 R JE AT 1) b e BB A S HEAT TR, A S Ut e

B 3h iR e AIB AT
(5P AR E S PO/ R A4 (10/100 Mbit/s) RS TR (AT
o AU R Bl i Ao, SRR, Sl AR PR el AE AR i i AT T T 3 %

EHE
o CEXUT A — AU s W IIE AT B, AR, A — NI TR PE RS 76 4% Ji B i
ERIEHE

BoR
B R A 5 W 2 v TGRS 1) B B TR VR A T AT A AR, U B R R

PC 214 54%#
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2k PC 1%

e AT s

4.7 M4 PC 3

b7 &

RI28 4

AHZ WX EEERD

SHEBE

PC

CP 1613 i@l ab P2

1.

“@ ﬂ;ﬁﬁ ”» (Start) >
SIMATIC > SIMATIC NET
> “UFEHEG”

(Configuration Console)

2. “PC#” (PC Station) >

“BEBHL” (Modules) > “M
#@3%” (Network
Parameters)

T T AR AN e 4 A
M

PC

INTEL W 253G (oL
B AL A T Y 488 3 1
wy EE

—_

“FF4R” (Start) > “i&
E” (Settings) > “ ¥ H|mH
#&” (Control Panel) > “%&
HETH” (Administrative
Tools) > “JHHLEEL”
(Computer Management)
> “W &G (Device
Manager) > “ M %%3&AC
#%” (Network adapters)

2. LEFEMERIENRCAS .

«i#‘:» (F|Ie) > «E,K_.E»
(Properties)

4. “m4%%” (Advanced) ik

i

B R PRI -

WA EVERRS ORIRT P
I

o RPN T AL
o BERGHEEANT

]!

SCALANCE X400
SCALANCE X 300
SCALANCE X200
SCALANCE X 200IRT
ESM

OSM

it Telnet 5 Web
Based Management
(WBM) 417

il Internet Explorer i
AL S B TEAE :

http : \<TCP/IP Hil->

e
O0
AN
mang
Ch

AS

CP 443-1 i@ it Aab 2 g5

HW Config: CP 443-1 J& 11t >

“HIN” (Options) T >
“HAMLBCE” (Individual

Network Settings) 21

15 “ALH A BT
(Transmission
medium/Duplex) #7414
HErp CBRIAIRCE

Automatic setting)

PC A5

EAETF, 2007 4F 9 Hhi, ASE01235050-02
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ZHE PC 4f

4.7 HE# PC %

CEZEYs!
o HAEULH] (SIMATIC NET: TolkBUKMAZ#hl SCALANCE X-200)
(SIMATIC NET; Industrial Ethernet Switches SCALANCE X-200)

o FE{EULH] (SIMATIC NET; Tk PLIKMAZ #eil SCALANCE X-300)
(SIMATIC NET,; Industrial Ethernet Switches SCALANCE X-300)

o EAEULH] (SIMATIC NET; LBUKMAZ#edll. SCALANCE X-400)
(SIMATIC NET; Industrial Ethernet Switches SCALANCE X-400)

o AT (SIMATICNET; ILUKIACHHL; SCALANCE X-300; SCALANCE X-400)
(SIMATIC NET; Industrial Ethernet Switches; SCALANCE X-300; SCALANCE X-400)

e FJIF (SIMATIC NET; TMELUKK OSM/ESM)
(SIMATIC NET; Industrial Ethernet OSM/ESM)

4.7.9 ZERZEMEAEF. PEAER. RS E

i

ZAVHBAME . IBEAMEF MRS B SR, TR Al . AN E A E
DY ES YT

PR R BB T 2 S O i P R L 2R ER

L]
11 REHT PCS 7 JRAIHARAAE &, 7]Z% pcs7-readme (1.

Microsoft Z &M E4MEF

Siemens X} Microsoft 4%} Microsoft £:1f & %t. SQL Server il Internet Explorer i [t %4>
PEAEAMNE P AEARPEM T M. A8 PCS 7 M BEAMETF TG E, nI{EZ N SIMATIC &/
YH4H ID: 18490004 () F3K7.

EXER
o ez e A R GRS (HURY B4) 7 Ay

PC 214 54%#
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Z2F PC 5ff

4.7 HEA PC %

4710 WK EEGE PCS7 MZE2EE

faifr
UURBEEOS Z A WE, AT UM ES .

AL TIEAT PCS 7 RGNS, BN 2 BCE MM — 2. 55T e ) R R
S % A BB AT UMM -

Tk
JHI 7 e DU BB B4 B 5 51 PC 3

SEB
MEAHEUUG/E PC Fibfr PCS 7 Pras s ®E, ST UL N IR,

1. PGS “FFEE” (Start) > SIMATIC > “SIMATIC Z4£3#4H]” (SIMATIC Security
Control) > “4&##&E” (All Settings)-

AT IF “SIMATIC 2 44EH” (SIMATIC Security Control) X iGHE .

2. [ “SIMATIC %447 (SIMATIC Security Control) SFiEHE R 215570 (15 5, ARGk F6A
INAIUESEIS

“fE1E” (Save) FEH
BALN HX L . Al T PCS 7 (3 B R AEAE—A XML S0

“ITEN” (Print) 241
AN X% S . TN T PCS 7 1% B R I% 24T L.

“RNH” (Apply) #z4H
Reox W IXEEBEE

“JCH]” (Close) 44l
KA N FHIX S i

BoE BT K bk
FEIXFIEBL R, Windows [ K% FRPR S IR EFARAE

PC 413 54K
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ZHE PC 4f

4.7 HE# PC %

4711  fWfTEk Open PCS 7 ) Windows iy ki ¥ &

faifr

o

140

PSR RATS “TRER” > “BE” > “EHIER” > “Windows B K" .

“Windows Bjj‘k$5” XHEHEFT IF o

B CHIAN HRAE
CAE CFEPAIRS” HU, WoE LT RILHE:

- Jlid OPC [Ji%#:: “CCEServer” HikHE

- Wil OLE DB [i%#%: “SQL Server 2005” 53 i%AE
Rl YRR

“URERFET” RIEHES] T

“EH X S TEAEST T

A CHIPE XK SIERE
- EFIAREF NS PC s AT IR T .
AR “HE” . HE] “Windows By Kb X IEHER M .

243l it Open PCS 7 5 PCS 7 T #HATIMIN PC 3 T PCS 7 T.J [IJaRIM (1) 4k
R, AL TR

PC 412 5%
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L H PC I

4.7 HEA PC %

4712  WifEGE RS PC FILAR
YA TUAR TAE S T AT — SN 25 1

o WIS TUARHLE N TUAR PC SR . TUR TAEu O 1) PC ul (JIRS5 28 15 TAE
iR .

o NTMRSS S-S WA REG Y, it ZN RS AS B L

PC 35 TR LR
AAAE LU N TUARE R T
o L BEINLLK 9 190 4 38 ] s AHE K P 28 FL 2 (A8 SRS
o XJ T OS %5 1EHEE] COM 2 1) 2 1 il fid i 25 o 4

REBFEA THER RS (OS. BATCH) KM N %
HRTURN
1. % PC 54 mgsids:.

2. RDIEe T GEREEHIRS PCS 7, SRS HIRS) (Process Control System PCS 7;
Fault-Tolerant Process Control Systems) ' [{14i BB T E-1E o

Z Bl (OS. BATCH) HFins B
P B TR IS A 42
1. RIRET N G RfEml R4 PCS 7; AR B HIR4t) (Process Control System PCS 7;
Fault-Tolerant Process Control Systems) " I{1 1 W1 TE 1 .

SIMATIC B4R 5l i B hn b B

1. BT GEFEPEH RS9 PCS 7, SIMATIC #4245 (Process Control System PCS 7;
SIMATIC Route Controf) /& IR AH N1t B IEA T 4 .

4713  BWKRASTHS PC 3

faj
T RERS N S TR (ES) HAS. NI PCS 7 B H M7 H ik 4R PC i (OS.
BATCH. RCS) , iHHHMTLL P E, JERAE FEBIPHT PC i,
EpIEEYS)
PSR HEF N GIREEHIRSE SIMATIC PCS 7; THRASRS)
(Process Control System PCS 7; SIMATIC Route Control) /%4
PC 413 54K
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2 H PC 3
4.8 W IITERISENT RSP i 0

4.8 By An A A S AR i R

4.8.1 PCS 7 M infe 5L 2 ik

i
AEI PEMEA I PCS 7 (RN ¥ A0S TR (045 6

Bk

o [Hnft:
- wEEWIIRE (5 143)
- DR AR (RS 146)
- ZEHLAE (RS 146)
— DiagMonitor (it 147)

o ST
- BT (5 150)
- WAELRE RS (5URY 151D

PC Al 54%
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2 PC

4.8 RIS FE 774 e T

482 TR 2 W IhRE

T PCS 7 ] HIZ 22 Wi AT AR B AL TR

ABTH “NetMeeting” #:1E KRG RENKITFEZ W PCS 7 T LW 2AT Windows XP
Professional 1 Windows Server 2003 (1] PC st 4T 45 B35 1] o

Establishing a connection via the
“Netmeeting” program

B ™ N

Customer Support PC Station in
| - - | Service Personal PCS 7 Plant | - - |
\ \

R
Bl vl LLUE L DL B AR A T A 4
o iRZ CRBIAIEE
o TCP/IP &4 (T.) WERMIZRER)
ZEMEXR
WX PCS 7 T.) $ATIEFE ST, iBh 1R T 32 B AR LRI .
PSP AR, IR B LIS . A SR Ak b St X e s A4 i, A RENS b 1) R
HAR RS
PC 414 54240
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ZHE PC 4f

4.8 1 1RSSR s

B K58 4 T 3RS A NetMeeting

144

L E S Windows [ k8%, 0420 K 18 ] NetMeeting ¥ & 4911 41 .

1. WEERaS “TFER” (Start) > “WE” (Settings) > “#H|E#R” (Control Panel)> “Windows
B k% ” (Windows Firewall).

AT IF “Windows Bl k857 (Windows Firewall) 15 HE .
2. ¥ “f4h” (Exceptions) LT+,
3. % “EFEEH” (Remote Desktop) .

4. ¥l “WSINFEAA...” (Add Program...).
BATIF “WInFEF” (Add a Program) X i

5. i “W%” (Browse).
fE “W%” (Browse) XJiEHER, 1EFE “C:\Program Files\NetMeeting” ¢35k .

6. P “confexe” Xt

7. ¥ “4TFF” (Open). #ifi “#ig” (OK).
“NetMeeting” FLF-#asing] “FEfkS:” (Programs and Services) 41 .
“NetMeeting” HES: ik .

8. ¥y “Hix” (OK).
1E “FEFFRIRSS” (Programs and Services) 41 % H1ik#% “NetMeeting” .

9. il “gwiE” (Edit).
BFIT “4miiFiF” (Edit a Program) XFHEHE .

10. %0 “H L. (Change scope...). #HT 1) H & w E
WL B XAER G ST RN D

1158585 “#fie” (OK).
125405 “#fiE” (OK).

FHTIF “Windows 5k 5% (Windows Firewall) $Fi5HE,  “f5il4h” (Exceptions) 114k T3k
HORAS

13. 5185 “USINFE...” (Add Program...),
BATIT “UINFERE” (Add a Program) X5 HE .

14,5915 “W%” (Browse).

15 B FHRAE RGN RGP ST “mnmsrve.exe” .
Wb %S, IESCPEAE T “C:\Windows\System32” i,

16. 7105 “3TJF” (Open). iy “HiE” (OK).
A “mnmsrve.exe” FRINE] “FEFERIRS” (Programs and Services) %l # .
“mnmsrvc.exe” HESHEIEH .

PC Al 54%
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L H PC I

4.8 1T RIS R P E s

1758 “HiE” (OK).

18. 11l “gwfi” (Edit).
KT “gmiEFE/y” (Edit a Program) X ifAE .

19. 8 “HHEHEL..” (Change scope...). AT L) & (1% E .
Uik AEXFR GaACHEBCHEALR D

20. %15 “HiE” (OK).

21.58:4 “Hie” (0OK).
BHTIT “Windows Bii k5% 7 (Windows Firewall) X 1iHHE

22 9k “HiE” (OK).
B N R

BEEZER
o T GUFHSHIZRL PCST; APEEIN PCS 7; SEUAIERL I
(Process Control System PCS 7; Security Concept PCS 7; Recommendations and Nofes)
o HAERGHLH D)
® |[nternet: http://support.microsoft.com/kb/878451/en-us
(http://support.microsoft.com/kb/878451/zh-cn)
PC 41 54
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& H PC 7f
4.8 1 1RSSR s

483 REEEER

WERMEF
AIAE LR 222 NIE W T PCS 7 [ # A 14 e
DU s R D4 AER T PCS 7:
e Symantec AntiVirus Corporate Edition
® McAfee VirusScan Enterprise

® Trend Micro OfficeScan Corporate Edition

PiE
HRHT PCS 7 MU RRAAE K, "1 2% pes7-readme LA .

I
it

ST M EdE =2 2] PC vl

=

EEZER
Dife Tl CERE RS PCS 7: Ao 4 Fi R P R R i A 2 1800
(Process Control System PCS 7; Nofes and Recommendations for Configuring Virus Scanners)

484 ZI AR A

(kN
H TR PERE AT, WIAE B R AE PC sl A I EHs RS ¥ 4% o S USUNAE TR, -4
FHEE AR 3645 (1, CD/DVD ZIs-AL)

£, PC
U R S 1) TREI 2 7 fh B — 870, 2™ i B R AR LS WU A o IR SR LA 7T DL
LRGE N A AT 2
LRI, TR IR R SR LT 3 7 A U AT SR

PC 214 54%#
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2k PC 1%

4.8 W ITERISENT R/ P i 0

4.8.5 DiagMonitor

fai g

DiagMonitor #4115 W1 &% AT 2 SIMATIC PC _E AAGAF R0 R ) . 31 8 r il i DA 34
At

e LUK (SNMP)
o Internet/Hi%
- PR
- SMS
e OPC (%] SIMATIC #EN FIFEF)
® Web il 2%
DiagMonitor #ffFox it it #REF ok SIMATIC PC 1 R e 5E RS .

BEfFEE K
A SIMATIC PC AJ FIAESZ I AL TS AL
e SIMATIC Box PC 620
e SIMATIC Box PC 620 V2
e SIMATIC Box PC 627
e SIMATIC Box PC 627 B
e SIMATIC Box PC 840
e SIMATIC Box PC 840 V2
e SIMATIC Microbox PC 420
e SIMATIC Panel PC IL 70
e SIMATIC Panel PC IL 77
e SIMATIC Panel PC 477
e SIMATIC Panel PC 670
e SIMATIC Panel PC 677
e SIMATIC Panel PC 870
e SIMATIC Panel PC 877
e SIMATIC Rack PC 547B
e SIMATIC Rack PC 627 B
e SIMATIC Rack PC 840
e SIMATIC Rack PC 840 V2
e SIMATIC Rack PCIL40 S
e SIMATIC Rack PC IL 40 S V2
e SIMATIC Rack PC IL 43

PC 41 584
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& H PC 7f

4.8 1 1RSSR s

WHFEK

B 51

DiagMonitor #fF 1] 55 LL T A R 48—t ] -

Microsoft Windows XP
Microsoft Windows Server 2003

Microsoft Windows XP Embedded (SIMATIC PC BOX)

W

I

/7

AEIEL TCP/IP Internet Wpl AT RN, BN X PSR S R A5 DT 5 1) SNMP .

%4 DiagMonitor 3k {4

148

1.

o > w0 N

1t DVD K&} %4 A PCS 7 Toolset DVD.

7F Windows # YR ELLS 1, T JF3C 3% Additional_Products > DiagMonitor .
iz4T Setup.exe X ff.

AT 2P TP 5 .

M “HfE” (OK).
F4TH “SIMATIC PC DiagMonitor Z23%” (SIMATIC PC DiagMonitor Setup) X} 1HAE .

ICUTE M INE P e X - (B

WA BHs DiagMonitor B 1F 22 AE R E I HAR SR, wlHiily “J%” (Browse) >k
IR AT

“RHERT” (Setup Type) & H AT A 23k WUl Lk £

- HEX (Custom)
WIRIERE “ HE X7 (Custom) ke, WA e e I e e i

- JFk (Development)
WHERE “FFR” (Development) 223, AN 222 H 7 1] SR FF & R AN FHRE P IR0 4F

- 584 (Full)

WRIERE “5eA” (Full) 2e3%, WLpradaift. Hpass «\e X7 (Custom) F1 “FF
%" (Development) %% {1204«

PC Al 54%
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LR PC I

47 SMS k%

PC 4l 51

4.8 1T RIS R P E s

e “HEX” (Custom), MRJ5Hidi “ F—2” (Next).

vt Bg
Siemens T PC 3 F DiagMonitor {4

Hd “F45” (Next).
FATIF “HE” (Question) X TEAE .

WA HAZS SMS kss, MIELE “27 (Yes) KEIZ bl dl, SRf5IERIRSGIULR .
ARIETERELEL, 7IS% “47 SMS ik 7.

10,5050 “3EH 7 (Exit).

A 00BN

WAIREEE A ) Windows/THSHAL, AR5 A BEAT HIZ AT .

CIERSERA A “RIHER” (My Computer) > “EIE” (Manage) > “ RS- MM T

(Services and Applications) > “fii4-” (Services).

HEPE “SNMP IR%:” (SNMP service) &t “SNMP”

TEPRFESE L, RS “#IE” (Action) > “JB1:” (Properties).
WEFE “224” (Security) EIR,

LEFELU Rz —

& EVLEE T “H%2 SNMP #1441 (Accept SNMP packages) i1
- AHEBATHERE.

HH S AL 1) “ 8252 SNMP KR4 (Accept SNMP packages) %17

— AU N EE AL AR (A s bk me AR M SO AL DL R T AR R Rl (U0 MS
g5 a5 P AN LR .

RN % A A B L4

TE “RZ PR 4 TR (Accepted community names) I i AFE 2H A T8 FH ) 2L AT 1525 15 i) AL
BRIP4 FK
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2 H PC 3
4.8 1 1RSSR s

447 DiagMonitor

L]

LIRS LAS ) “E BN 7 (Management Station) 22 T B H g iy A8 AR A P B 5.
TWﬁM“ﬁmﬁiﬂﬁ@*

1. PSR A “FFER” (Start) > SIMATIC > PC DiagMonitor > “& 234 ” (Management
Station).

#4TIF “SIMATIC PC DiagMonitor” XJifi#E .
2. PR A “B5” (Station) > “¥in” (Add).
3. HHATLU A
HERE “AHbuk” (Local station) ik “ ARVFUF AT 5" (Allow access to all stations) #E,

B “ARnT (Add) JERIA AN PC St “44Fkak IP Hulik” (Name or IP address) (44ilt1,
YR S5 AR A4 PR EL 1P kb))

- WRTE, ABBERF, Gl FEEAT DI RE CTIERED

— W “SIMATIC PC DiagMonitor” &5 BRuSLEREV ] S8 sk A RS, s “IF
15”7 (Start) > “FEF” (Programs) > “ H3)JH3)” (Autostart) 1) “iHG” (Management
Station) < H -

4.8.6 BRERFER

BRI R P
{E%E4T PCS 7 (1) PC _EARGEAEHI S rdm e, T

o REORY TP CPU I, i/l RS HHE .

o SRR AW T ] RAM. AT AR, SELE BRI R AN RETSCE A ME T R A A7
DX 42k

WA T DR Ry RSy, 81T PCS 7 I NAEH &

PC 214 54%#
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Z2F PC 5ff

4.8 1T RIS R P E s

4.8.7 WAL

i PR 1y SR EERR
W T P B PP T T SR 45 L e REE PO )

TR

WAL P AR B P R s A 2 B, W] RS ORVF m] UE 8 B SO AT A L2 BT 5 14
e

W

FEIEAT WALy 8 PRI U6 2 K SRV AT P HEERAE S o

KB BUVF AT IEE A HEBRZE AL B 2 A1
AL RE P HEBRIAUVF P UEE B, A7 LR JUR IV vl ik £
o CKE T SEBUVE AT BE A% 1A B BB AV I P A
o KT A RAUVE AIE B PIE IR B AT LSRR S B 0 X (B, RO .

PC &S5
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PC Al 54%
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Pt %

5.1 fiYsR A - TR A H

5.1.1 ERATHRAS®HEL

FA TR SN AR Z iR

NHEEAR TS NIRRTt PCS 7 T HA DVD ¥ PCS 7 REWAFEIT ke, MHIXELN

JRE 3 i SEVF TR ] o

ARETENEZER, WS% PPl A PCS 7 #Al (5ifh 108) 7 #47.

NARF R iR

Automation License Manager | F T~ 126 Fl4 £ 17 ] {1F 8545

STEP 7 PCS 7 FEA T FE:
o HTEHMITHX M SIMATIC & B
o M TEHTHAHECE Y HW Config
o T AT AN NetPro

SCL SEF ki = (S7 SCL, Structured Control Language)
AT 8 1EC 61131-3 brdEdhAT P DhRes e ) s 20E 5

CFC ES:1E K (CFC, Continuous Function Chart) — H T4 IEC 61131-3
FRAERTIELE B S Dh REdHAT BB ALES,  BAT IR D) e

SFC W h e (SFC, Sequential Function Chart) — F 5% I3 42 7= i 1k
ITEEAALS CObisfdr) , BAWFR 6

PH T.J )24 (PH, Plant Hierarchy) — HIF7E T ME P SR H; MHH
Refg PUd T I 10 H BRI AL

IEAPO o X% (PO, Process Object) L& — TR ALIEA B sh b Bz 1Y

T sk s il ) PRI
o SASHBIF (IEA, Import Export Assistant)
HREFBHELZELS, ATS% “RIERA (005 157) 7 #H5

PCS 7 A T S F A R B A R DA B SR AN R (B dn, - 1/O A%
BB bR R i

WinCC AT TR, AL S TE BN AN Sl B AR o DT S B fi] B0 3] 42 )y
AT S5 I br

PC A5
EAETF, 2007 4F 9 Hhi, ASE01235050-02
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HiR

5.1 R A - HIFERITENT

N fRIZEHIR
AS-0S TF A S AIBR%E I AS/OS %

PV Insinfo /It %%

4y WinCC Az & Wit fe it ES AR T H

SIMATIC NET PC #

JITAZAbRN PC 2255 (¥ 4 443 O a (K A AL

BATCH Engineering

T BATCH TSR

BATCH /. BATCH 45 2%. BATCH B, BATCH WinCC % /T Hlik
Jit, BATCH WIinCC k%5 231%35. BATCH AT 457

AR TEMEZER, 5% “SIMATIC BATCH /£y

(GRS 155) 7 #B5%.

Route Control Engineering

Al TRE A ALPE

FEARBRACAE N AR TR BRI . R AR AR
ARIETEEHELZFEE, 5% “SIMATIC Eie il H/Ht
(RS 156) 7 4%

PDM

H TG % TR A M
ARETEGTEZER, AI2% Dl (s 157) 7 #5r.

5.1.2 BAE R R

BAE ot LR P ) R B R

B RS R AN Rt PCS 7 T HA DVD i) PCS 7 R HFE 7 2ede. HIXLEN

PR P 7 EEVF AR 2 5

ARG, WS% “PCS 7 WAV AIZA (165 108) 7 #B45).

B2 T EHIR
Automation License Manager | {32 A1 H# Vv E 2541
WinCC TR TAESE B TAESBE N 24T AT Ak B T R RN 2 2 3

VR LR PIE
ARBTEEWFEL, IS% R EMAVE IR AR (i 113) 7

T

SFC Visualization

AT DL R AR U R 5

PCS 7 Faceplates

A AT L I BUR R bR e CERE] AS FNTIIO

SIMATIC NET PC software

AT RS AL (R AR A AL S AR DU PC o222 1) ) 28 S I 2

154
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KR

SIMATIC BATCH #4441,

SIMATIC BATCH R F #2571 o iR

5.1 R A - HIFERIEN

SIMATIC BATCH i R %)% HFE-H PCS 7 T A4 DVD /1] PCS 7 R4 w32, M
TN R 5 BV A UE S

ARHEAER, WE% “PCS 7 HATVF R AEZAL (TTF% 108) 7 #7).

AR

oy AR

Automation License Manager

FHTARIEFIE PV A e 2 B

BATCH Base

FT BATCH 2235 [kl
ALFE R P MU 17 1) 22 5%
TV UF R4k 52 BATCH API 5 T Bifb i S S R G 6%

BATCH Builder

ZHHAE PCS 7 ES LY. HATRIEAIZAZ BATCH i B Hods i -
e OM

e Builder

BATCH Fastobject

T e B B R 55 45
e POET Server
e BATCH DBMON

BATCH Client

e BCC - fit:/=#5¢h7.0 (Batch CC) /& SIMATIC BATCH 1Tt
RUAE A = st rpots 41 #F . Batch CC ¥4 # 55 SIMATIC BATCH
IS St . IR AT LAAE Batch CC Hid St BT $udfs -

o BATCH Mty g A3 FH T AT AT B 0 7 (1) ) 24 P T 60 R A 38

e BATCH 3 - BATCH [{JH /' K3 F4T En s fig

BATCH Server

e BCS - BATCH [l 742 il &R 45l i 43 ic
e CDV (BDM) - #t/E =Sl BRI . 176k 03RS A P8
o VFATIEZ5EHTE [

HRIEFEGEE, WS “ReBEmh Al ik 2 81 2L

(TG A13) 7 #4y.

BATCH Blocks

BATCH 405

BATCH WinCC Client Options

PCS 7 OS [T

BATCH WinCC Server Options

PCS 7 OS [#THIH

BATCH Getting Started

SIMATIC BATCH #5451 55 H

PC A5
EAETF I, 2007 4F 9 JIh, ASE01235050-02
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HiR

5.1 R A - HIFERITENT

5.1.4

SIMATIC #4256 R AFE

SIMATIC #5424 i N F 27 1 16 E ik

SIMATIC BAREHIR T AN AR feilid T 248 DVD %23 PCS 7 (i ferb2e3s, ffiHix
e R FHRE e e VU A

ARHEAER, WS% “PCS 7 ATV AEAL (ITF% 108) 7 #oy.

156

L E

] ZE R

Automation License Manager

F ARV BEVE ) IE B 8.

Route Control Base

BT B A g thl e B ) S
£ SIMATIC E 4547 il SC kY

Route control client

A LR TR 2

Route Control Engineering

TG RVE PR 5 0 3R R S8 H (3 2 B A2

Route Control Server
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